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Getting started

Welcome to Terminal Services Manager - a tool that lets you monitor and administer Remote Desktop

Services (RDS) servers, the users connected to them, their sessions, and the processes running inside

those sessions.

From one window you can see which servers are online, who is signed in, how long each session has been

idle, and what each user is running. You can disconnect or log off users, send them messages, shadow a

session, end a process, or restart a server, all without opening a remote desktop connection to each

machine.

This section walks through what the program can do, what you need to run it, how to install it, and how to

find your way around the main window. Start here if this is your first time with Terminal Services Manager;

once you know your way around, move on to building your computer list.

In this section

• Introduction - what the program does and who it is for

• System requirements - supported Windows versions and prerequisites

• Installing Terminal Services Manager - run the setup program step by step

• Installing with winget - install from the command line with the Windows Package Manager

• The main window - a tour of the panes, menus, and toolbar

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/
https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/introduction/
https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/system-requirements/
https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/installing-terminal-services-manager/
https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/installing-with-winget/
https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/main-window/
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Introduction

Terminal Services Manager is a Windows administration tool for Remote Desktop Services (RDS). It

connects to one or many Windows servers at the same time and shows, in real time, who is logged on, what

they are doing, and how the server is performing. From the same window you can disconnect or log off

users, send them messages, shadow active sessions, terminate processes, and run common administrative

tasks on the remote computers.

What you can do with it

• Monitor any number of RDS servers in parallel. The Servers tab shows per-server CPU and memory

load, RDP bandwidth, disk activity, network throughput, session and user counts, and several

frame-quality metrics for the RDP protocol.

• See who is connected. The User sessions tab lists every interactive session across the monitored

servers, with idle time, logon time, client name, and resource usage per user.

• Inspect running programs. The Processes tab lists processes from all monitored servers with CPU,

memory, handle and thread counts, optionally filtered by user, server, or executable name.

• Take action. Disconnect or log off users, reset sessions, shadow a session, send broadcast or targeted

messages, terminate processes, reboot or power off a server, and connect to a server with the standard

Remote Desktop client - all from the context menu of the relevant tab.

• Inspect history and events. Open the RDS event log, browse session history, and review failed logon

attempts for any monitored server.

• Plot anything that changes over time. Each tab has a graph panel that can chart any combination of

the available metrics with adjustable time window, grid, legend, and tooltip modes.

• Manage RDS configuration. Open the Remote Desktop Services Properties dialog, view installed RDS

licenses, enable or disable Remote Desktop on a server, and manage user profile folders.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/the-processes-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rds-event-log/
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• Bring servers into the program in bulk. The Add computers wizard can import targets from Active

Directory, an IP range, a network broadcast scan, a Hyper-V host, an RDS Connection Broker, SCCM, or

WSUS.

What it is not

Terminal Services Manager is a monitoring and administration console, not an RDP client. To open a remote

desktop session it launches the standard Microsoft Remote Desktop client (mstsc.exe) and lets that client

own the session.

Continue with System requirements or jump straight to Installing Terminal Services Manager.

System requirements

Computer that runs Terminal Services Manager

• Operating system: Windows 10, Windows 11, or Windows Server 2016 / 2019 / 2022 / 2025.

• Architecture: 64-bit (x64).

• Disk space: about 50 MB for the installation, plus a small amount for application data and the local log

file.

• Display: 1280 x 800 or higher. The interface scales correctly under per-monitor DPI on Windows 10 and

later.

• Network: routable access to every server you want to monitor (TCP/IP). Domain membership is not

required, but using domain credentials is the easiest way to authenticate.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/
https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/system-requirements/
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Servers you want to monitor

Any Windows version that ships Remote Desktop Services and its supporting WMI / RPC interfaces. In

practice this means:

• Windows Server 2012 R2 and later for full RDS server monitoring.

• Windows 10 / 11 for monitoring desktop sessions on individual computers (Remote Desktop on a

workstation).

For each remote computer the program uses several Windows administration interfaces:

Feature Protocol used Default ports

Session and user lists RPC over SMB (WTS API) 445/TCP

Performance counters (CPU,

memory, disk, network)
PDH / Remote Registry 445/TCP, 135/TCP

Server state probes configurable: ICMP, TCP, or WMI 7/TCP, 135/TCP, ICMP

Failed logons and RDS event log Event Log RPC 135/TCP + dynamic

Remote Desktop sessions RDP 3389/TCP

The account you run Terminal Services Manager under must have administrator rights on the remote

computer. For workgroup or cross-domain scenarios, run the program under an account that has those

rights (see Connection credentials).

What needs to be reachable

On the remote computer make sure that:

• The Remote Registry service is running. It is required for performance-counter collection and is not

started by default on workstations.

• The firewall allows Remote Service Management, Windows Management Instrumentation (WMI),

and File and Printer Sharing for the network profile you are connecting through.

• Remote Desktop Services is installed (always present on Windows Server; needs to be enabled on

workstation editions through System Properties).

The method used to decide whether a server is reachable is configurable on the Network preferences page,

where you can switch between ICMP, TCP, and WMI probes.

Installing Terminal Services Manager

The easiest way to install on a modern Windows machine is through winget; see Installing with winget. The

sections below cover the interactive installer and the underlying command-line switches you can use when

winget is not available.

Download

Get the latest installer from the LizardSystems download page. The file is named

tsmanager_setup_<version>.exe.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/connecting-with-alternate-credentials/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-state-verification/
https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/installing-with-winget/
https://lizardsystems.com/download/
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Install interactively

1. Run the installer. If User Account Control prompts, confirm to allow it to make changes, then choose the

language to use during setup.

1. On Select install mode, choose Install for all users (recommended; needs administrative rights) or

Install for me only.

1. Read the license agreement, choose I accept the agreement, and click Next.
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1. Choose the installation folder. The default is C:\Program Files\LizardSystems\Terminal

Services Manager.
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1. Pick the additional tasks, such as Create a desktop shortcut, and click Next.
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1. Review the summary on the Ready to Install page and click Install.
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1. Wait while the files are copied.
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1. On the final page, leave Launch Terminal Services Manager ticked (and, if you like, Visit Terminal

Services Manager web site), then click Finish.
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Silent install without winget

The installer is built with Inno Setup. The following switches are recognized:

Switch Effect
/VERYSILENT No installer UI.
/SILENT Show only the progress window.

/SUPPRESSMSGBOXES
Combined with /VERYSILENT or /SILENT,

dismisses confirmation dialogs.

/NORESTART
Suppress the automatic reboot prompt if one is

needed.
/SP- Skip the initial "This will install..." prompt.
/DIR="<path>" Override the installation folder.
/LOG="<file>" Write an installation log to <file>.

Example (matches the switches winget itself passes):

tsmanager_setup_<version>.exe /VERYSILENT /SUPPRESSMSGBOXES /NORESTART /SP-
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Uninstall

Open Settings > Apps > Installed apps, find Terminal Services Manager, and choose Uninstall. The

uninstaller removes the program files, registry keys, and Start menu shortcuts. Application settings and the

saved computer list under %APPDATA%\LizardSystems\Terminal Services Manager are kept by

default so they can be reused after a reinstall; delete that folder manually for a clean removal.

If you installed through winget, use winget uninstall tsmanager instead.

Updating from inside the program

When a new version is available, the program offers to download and install it the next time it is started. You

can also check for updates at any time from Help > Check for updates....

Installing with winget

Terminal Services Manager is in the Microsoft winget repository. The moniker is tsmanager and the full

identifier is LizardSystems.TerminalServicesManager. Examples below use the moniker; the full

identifier works wherever the moniker does and is less ambiguous in scripts.

Make sure winget is available

Windows 10 / 11 desktop

Winget ships as part of the App Installer component and is usually already there. If winget is not

recognized, install App Installer from the Microsoft Store, or register it from PowerShell:

Add-AppxPackage -RegisterByFamilyName -MainPackage Microsoft.DesktopAppInstaller_8wekyb3d8bbwe

https://lizardsystems.com/terminal-services-manager/help/handbook/updates-and-licensing/checking-for-updates/
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Windows Server 2025

Winget arrives through Windows Update. Install the latest cumulative updates.

Windows Server 2019 / 2022

Not pre-installed. Bootstrap it through the Microsoft WinGet PowerShell module:

Install-PackageProvider -Name NuGet -Force

Install-Module -Name Microsoft.WinGet.Client -Force -Repository PSGallery

Repair-WinGetPackageManager -AllUsers

Open a new terminal session afterward and verify:

winget --version

Install

winget install tsmanager

Terminal Services Manager appears in the Start menu when the installer finishes.

Upgrade an existing manual installation

If you previously installed Terminal Services Manager from the website, winget can still take over upgrades.

It identifies the package by the product code in the Windows registry, so a manually installed copy is

recognized as already-present.

winget upgrade tsmanager

Settings, computer lists, message presets, and custom commands are kept.

Silent install for deployment

For setup scripts, Intune, SCCM, or any other automation:

winget install tsmanager --silent --accept-package-agreements --accept-source-agreements

--silent suppresses installer UI. The --accept-* flags skip the interactive prompts that block

unattended runs.
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Roll out across a fleet from a PowerShell session:

$computers = Get-Content ".\server-list.txt"

foreach ($computer in $computers) {

   Invoke-Command -ComputerName $computer -ScriptBlock {

       winget install tsmanager --silent --accept-package-agreements --accept-source-agreements

   }

}

To replicate a full toolset of admin packages across machines, export from a reference workstation and

import on each new machine:

winget export -o admin-tools.json

winget import -i admin-tools.json --accept-package-agreements --accept-source-agreements

Update

Check whether a new version is available:

winget show tsmanager

Update only Terminal Services Manager:

winget upgrade tsmanager

Or update everything winget manages on the machine:

winget upgrade --all

The program's built-in update checker does not conflict with winget. Use whichever you prefer.

Pin a version

During a change freeze, or to stay on a known-good version:

winget pin add tsmanager

winget upgrade --all then skips Terminal Services Manager. Remove the pin when you are ready:

winget pin remove tsmanager

Pin to a version range to allow patch updates but block major changes:

winget pin add tsmanager --version 26.*

Uninstall

winget uninstall tsmanager

https://lizardsystems.com/terminal-services-manager/help/handbook/updates-and-licensing/checking-for-updates/
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Troubleshooting

• winget is not recognized. Winget needs Windows 10 build 1809 or later. On older builds it is

unavailable. On Server 2019 / 2022 use the PowerShell setup above.

• No applicable installer found. Terminal Services Manager is 64-bit only.

• Package not found. Refresh the source index: winget source update.

• Installation requires elevation. The installer writes to Program Files. Run the terminal as Administrator,

or accept the UAC prompt.

• Upgrade does not detect an existing install. Happens when the existing copy was installed under a

different user account or with a non-standard product code. Uninstall manually, then install through

winget.

The main window

The main window is divided into four working areas. Once a few computers are loaded it looks like this:

1. Menu and toolbar

The menu bar across the top groups every command. Items that act on a specific kind of object live in their

own menu: Computers for the computer list, Servers, Users, Processes for the data tabs, and Tools for

utilities such as custom command-line tools. The File, View, and Help menus carry application-wide

commands.

The toolbar exposes the most frequently used actions as buttons. Hover over a button to see its name.

Some buttons are enabled only when there is something to act on - for example, the Delete button is

enabled only when a computer or group is selected in the computer list.
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2. Computer list

The left panel holds the list of computers that the program will monitor. Computers can be grouped into

folders; the group structure is purely organizational and does not affect monitoring. The checkbox next to

each computer or group decides whether it is currently monitored - clearing the checkbox stops collection

from that machine without removing it from the list.

The Search string field at the top of the panel filters the tree by name; only entries that match the search

remain visible. To go back to the full tree, clear the field with its X button.

3. Information tabs

The right side of the window has four tabs:

• Servers lists every monitored server with its current CPU usage, memory usage, RDP bandwidth, disk

and network activity, and counters for sessions, users, and processes.

• User sessions lists every active user session across all monitored servers, with idle time, logon time,

client name, and per-session resource usage.

• Processes lists every process running in any of those sessions, with CPU, memory, handles, and

threads.

• Application log shows the program's own runtime log - useful when investigating a connection problem

to a server.

Each data tab has its own filter bar above the grid: a quick-search field, a Filter button that opens the filter

builder, and quick preset buttons for common queries such as High CPU (>80%). Right-clicking a row opens

the context menu with all the actions that apply to the selected item.

The header of each grid is your control over columns. Click a header to sort by that column, drag headers to

reorder them, and right-click the header strip to show or hide individual columns.

4. Graph panel

Below each data grid is a graph panel. The tabs at the top of the panel choose which metric is drawn; you

can have several graphs open at the same time (one per tab). Each graph plots the value over time for

every checked row in the grid above. Right-click the chart for options such as pausing, switching the legend

mode (current, average, minimum, maximum), changing the time window, copying the image to the

clipboard, or exporting it as a PNG.

If you want a different set of metrics in the panel - or you want to hide a metric you do not use - right-click

the tab strip at the top of the graph panel and choose Graph settings..., then tick only the ones you care

about.

Status bar

The bar along the bottom of the window has seven panels, left to right:

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/searching-the-computer-list/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/the-processes-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/the-application-log-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-overview/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graphs-overview/
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1. Status text - the leftmost panel. Shows progress messages for long-running operations such as a

refresh or a wizard scan; otherwise blank. Its width tracks the computer list panel above it.

2. Servers: N - count of monitored servers.

3. Users: N - total user sessions across those servers.

4. Active Users: N - sessions whose state is active.

5. Idle Users: N - sessions whose state is idle.

6. Disconnected Users: N - sessions whose state is disconnected.

7. Processes: N - total processes across all monitored sessions.

The counter panels are fixed width; only the leftmost status-text panel resizes, tracking the computer list

pane.

Resizing the layout

The vertical splitter between the computer list and the information panel, and the horizontal splitters between

each data grid and its graph panel, can be dragged to give more room to whichever area you are working in.

The layout is remembered between sessions.
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Building your computer list

The computer list is the left-hand pane of the main window. It holds every computer you want Terminal

Services Manager to monitor, organized into folders that you control. This section explains how to populate

it: add machines one at a time, paste a list of names, generate names from a pattern, or pull them in bulk

from a network source. It also covers grouping, bulk maintenance, and saving and restoring the list as a file.

Right-click anywhere in the computer list to reach these commands:

How you build the list depends on how many computers you have and where their names live. For a handful

of servers, type each name in or paste a block of names. For a whole environment, the wizard can discover

machines from the network, Active Directory, an IP range, a Hyper-V host, an RDS broker, SCCM, or

WSUS. Once the names are in, group them into folders, search and filter, connect with alternate credentials

when needed, and export the list so you can reuse it on another machine or share it with colleagues.

In this section

• Adding a single computer - type one name to add a machine

• Adding multiple computers - paste a list of names or generate them from a pattern

• Adding computers using the wizard - discover computers in bulk from a network source

• Organizing computers into groups - sort computers into folders

• Bulk operations - act on many computers at once

• Importing and exporting the computer list - save the list to a file and load it back

• Connection credentials - connect with an account other than the one you signed in with

• Searching the computer list - find computers quickly in a long list

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-a-single-computer/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-a-single-computer/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-multiple-computers/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/organizing-computers-into-groups/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/bulk-operations/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/importing-and-exporting-the-computer-list/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/connecting-with-alternate-credentials/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/searching-the-computer-list/
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Adding a single computer

The Add computer dialog adds one machine to the list, or edits an entry that is already there.

Opening the dialog

Choose Computers > Add computer... from the main menu, or right-click the computer list and pick Add

computer.... The dialog title is Add computer for a new entry and Edit computer when you opened it on

an existing one.

General tab

• Computer name or IP address - the host name, fully qualified DNS name, or IP address of the target.

The ellipsis button on the right opens the Windows Select Computer dialog so you can pick a computer

from your environment. The name cannot contain the characters \ / : * ? " < > |.

• Description - free-form text shown next to the name in the list. Use it for room numbers, owner names,

or any reminder you find useful.

Notes tab

A multi-line text box for longer notes. Anything you type here is saved with the entry and travels with import

and export.

Saving your changes

Click OK to add the entry to the list (or save your edits). Click Cancel to discard them. If the Computer

name field is empty, OK stays disabled.

See also: Connection credentials, Organizing computers into groups.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/importing-and-exporting-the-computer-list/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/importing-and-exporting-the-computer-list/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/connecting-with-alternate-credentials/
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Adding multiple computers

The Add multiple computers dialog generates a batch of computer entries from a single pattern. It is the

fastest way to add a numbered fleet (PC-01 through PC-30), a labeled set (SRV-A, SRV-B, SRV-C), or a

combination of both.

Opening the dialog

Choose Computers > Add multiple computers... from the main menu.

Pattern syntax

Type a pattern into the Computer name pattern field. The dialog supports the following expansion

operators, which can be combined freely:

Syntax Expands to Example Result

{a,b,c}
each comma-separated

value
srv-{web,db,app}

srv-web, srv-db,

srv-app

[1-10] inclusive numeric range pc-[1-3] pc-1, pc-2, pc-3

[01-10]
numeric range with leading

zeros
pc-[01-03] pc-01, pc-02, pc-03
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[A-Z] inclusive alphabetic range rack-[A-C]
rack-A, rack-B,

rack-C

[aa-zz]
multi-character alphabetic

range
srv-[aa-ac]

srv-aa, srv-ab,

srv-ac

[1-10:2] range with step pc-[1-10:2]
pc-1, pc-3, pc-5, pc-7,

pc-9

Click the help button on the right of the field (or the right-side button on the editor) to open a dialog with the

full list of supported patterns and worked examples.

Live preview

The tree below the pattern field updates as you type. It shows the names that will be created and the total

count. Two safeguards apply:

• Only the first 1,000 names are shown in the preview; if the pattern generates more, the count below the

preview reads "N computer(s) will be added (showing first 1000)".

• The dialog will not let you generate more than 10,000 entries in one operation.

If any generated name contains an invalid character, the preview shows the error and OK stays disabled

until you fix the pattern.

Group name

Fill in Group name (optional) at the top of the dialog to place all generated entries inside a new folder of

that name. Leave it blank to add them at the root level. The same validation rules that apply to a manually

created group apply here.

Saving your changes

Click OK to write every generated entry to the computer list. Click Cancel to discard them.

See also: Adding a single computer, Adding computers using the wizard.

Adding computers using the wizard

The Add computers from... wizard discovers computers in your environment and adds them to the list in

one operation. Pick a source, configure it, watch the discovery run, then decide how the results fit into your

existing list.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/organizing-computers-into-groups/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/organizing-computers-into-groups/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-a-single-computer/
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The wizard works in three steps. First you choose a source and fill in its settings. Different sources need

different details: a domain name for Active Directory, a start and end address for an IP range, a host name

for Hyper-V. Next, the wizard scans that source and shows the computers it finds. Finally you choose where

the discovered names land in your list and what happens when a name is already there. Each source has its

own page below that explains its settings.

Opening the wizard

Choose Computers > Add computers from... from the main menu.

Step 1: Import from

Pick a source from the Import from dropdown:

• Network - browse computers visible on the local network

• Active Directory - query computer accounts from a domain

• IP range - scan a range of IP addresses (the default selection)

• Hyper-V - enumerate virtual machines on a Hyper-V host

• RDS - read session hosts from a Remote Desktop Connection Broker

• SCCM - query devices from a Configuration Manager site

• WSUS - read clients from a Windows Server Update Services database

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/network/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/active-directory/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/ip-range/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/hyperv/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/rds-broker/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/sccm/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/wsus/
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The panel below the dropdown changes to show the settings for the selected source. Each source has its

own page in this section that documents its fields.

Click Next > to start discovery.

Step 2: Search

The wizard runs the source in the background and adds names to the Found computers tree as they are

found. An activity indicator spins while the scan is in progress. You can:

• Wait for the scan to finish.

• Click Next > as soon as enough machines have appeared (further results stop being added once you

move on).

• Click < Back to change source settings.

If the scan finishes with zero results, Next > stays disabled. There is nothing to import, so the wizard

expects you to go < Back, switch to a different source or change the parameters, and try again. Cancel also

works if you want to abandon the operation.

Step 3: Finish

Pick a Target group for the discovered computers:

• Keep original grouping - keep the hierarchy returned by the source (for example, the organizational

unit tree from Active Directory).

• New group - put everything into a new folder. Type the folder name in the field below this option.

• Existing group - pick a folder from the dropdown of groups that already exist in the list.

Then choose how to handle names that are already in the list under Duplicates:

• Skip duplicates - leave existing entries alone, add only new names. This is the default.

• Add duplicate - add discovered names even if they duplicate existing ones.

• Replace existing - delete existing entries with the same name, then add the new ones.

Click Finish to write the discovered computers into your list. Click Cancel at any point to abandon the

wizard.

Sources

• Network source - browse computers visible on the local network

• Active Directory source - query computer accounts from a domain

• IP range source - scan a range of IP addresses

• Hyper-V source - enumerate virtual machines on a Hyper-V host

• RDS source - read session hosts from a Remote Desktop Connection Broker

• SCCM source - query devices from a Configuration Manager site

• WSUS source - read clients from a Windows Server Update Services database

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/network/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/active-directory/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/ip-range/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/hyperv/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/rds-broker/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/sccm/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/wsus/
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Network source

The Network source asks the local Windows network for computers it can see and lets you keep only the

kinds you care about.

Settings

• All computer types - return every computer the browser sees, regardless of role. This is the default.

• Only selected types - return only the categories you tick. Five checkboxes appear when this radio is

selected:

• Domain controllers

• Servers

• Terminal servers

• SQL servers

• Workstations

The role filter is applied at the Windows browser API level by passing the corresponding SV_TYPE_*

bitmask to NetServerEnum. A box that is unticked drops every machine of that role from the result.
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When to use it

The Network source uses the same browser service that Windows Explorer uses, so it sees what your

machine sees. The underlying NetBIOS protocol is deprecated, so it tends to miss machines on modern

networks - and the Terminal servers and SQL servers role bits in particular rely on legacy SMBv1

announcements that newer servers no longer broadcast, so those two filters can under-report. For larger or

modern environments use Active Directory or IP range instead.

Active Directory source

The Active Directory source queries the domain that the running machine is joined to and returns the

computer accounts it finds.

Settings

• Include disabled computer accounts - tick this box to include computer objects whose accounts are

currently disabled. Off by default.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/active-directory/
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What it returns

The source walks the domain and reports every computer object visible to the user who runs Terminal

Services Manager. The hierarchy returned reflects the organizational unit (OU) tree, so if you keep Keep

original grouping selected on the final wizard page, your list mirrors your OU structure.

Requirements

• The machine that runs Terminal Services Manager must be joined to the domain you want to query, or

have a working trust to it.

• The account running the program must have permission to read computer objects in the domain.

IP range source

The IP range source walks a contiguous range of IPv4 addresses and reports the hosts that respond.

Range settings

• Start IP and Stop IP - the inclusive endpoints of the range. The start address must be a valid IPv4

address; both endpoints are validated before discovery starts.

• Detect - fills in the range using the IP address of the local network adapter.

• /24 - rounds the current range to a /24 subnet (256 addresses) based on the Start IP.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/
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• /16 - rounds the current range to a /16 subnet (65,536 addresses) based on the Start IP. Use with care.

Discovery options

• Resolve computer names - do a reverse DNS lookup on each responding address so the list shows

host names instead of bare IPs. On by default.

• Add only responding hosts - skip addresses that do not respond to ping. On by default; turn it off to

add every address in the range regardless of response.

Group naming

The IP range source has its own grouping options that override what you choose on the final wizard page:

• No groups - add every discovered host at the top level.

• Single range - place everything in one folder named after the range (for example, 192.168.1.1 -

192.168.1.254).

• By subnet - split the results into one folder per subnet. This is the default. Two extra controls become

available:

• Mask - /24 (255.255.255.0), /16 (255.255.0.0), or /8 (255.0.0.0). Default is /24.

• Format - controls how each folder is named: Wildcard (192.168.1.x) or CIDR (192.168.1.0/24).

Hyper-V source

The Hyper-V source connects to a Hyper-V host and lists the virtual machines registered on it. It is one of

the discovery sources in the Add computers from wizard.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/
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Settings

• Server - the host name, FQDN, or IP address of the Hyper-V server. Leave blank to query the local

machine.

• Include powered-off VMs - tick this to also list virtual machines that are currently in the Off or Saved

state. On by default.

Requirements

• The account running the program must have permission to query Hyper-V on the target host. Members

of the local Hyper-V Administrators group on the host always qualify.

• The Hyper-V WMI namespace (root\virtualization\v2) must be reachable. The Windows Remote

Management service on the host must allow access from your management machine.

• The host must be Windows Server 2012 or later, or a Windows client edition with the Hyper-V role

enabled.

RDS source

The RDS source (listed as RDS in the wizard's source dropdown) connects to a Remote Desktop

Connection Broker and returns the session hosts registered with it. Use it to import every session host from

an RDS deployment in one step. Pick RDS on the first page of the Add computers from wizard.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/
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Settings

• Broker - the host name or FQDN of the RDS Connection Broker server. Leave blank to query the local

machine.

• Include offline session hosts - when ticked (default), every host the broker knows about is returned,

even ones currently unreachable. When unticked, hosts whose state is anything other than running are

dropped from the result. On Windows Server 2016 and later this uses the

Win32_RDSHServer.ServerState WMI property; on older brokers (Server 2012 / R2) that property is

empty, and the source falls back to a short ICMP probe (500 ms timeout) for each host.

What it returns

The source enumerates RD Session Host servers known to the broker (via the Win32_RDSHServer WMI

class). Discovered hosts appear as a flat list in the preview tree.

Requirements

• The machine that runs Terminal Services Manager must be able to reach the broker over WMI (the

root\cimv2\rdms namespace).

• The account running the program must have permission to read deployment information from the broker.
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• For the offline filter to work on older brokers, the management machine must be able to reach the

session hosts with ICMP echo (allow File and Printer Sharing - Echo Request in the host firewall, or

accept that hosts behind ICMP-blocking firewalls are reported as offline).

SCCM source

The SCCM source pulls device records from a Microsoft Endpoint Configuration Manager (formerly System

Center Configuration Manager) site. Use it when SCCM is already your authoritative inventory of clients and

servers. Choose it as the source on the first step of the Add computers from wizard.

Settings

• Server - the host name or FQDN of the site server. Leave blank to query the local machine.

• Site code - the three-character site code (for example, PS1).

• Include inactive clients - tick this box to include devices that the site marks as inactive. Off by default.

Requirements

• The account running the program must have read access to the SCCM WMI provider

(root\sms\site_<code>).

• The site server must be reachable from your management machine over WMI / WinRM.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/


Terminal Services Manager - Terminal Services Manager handbook

WSUS source

The WSUS source reads client computers directly from the SUSDB database that Windows Server Update

Services uses. Use it when WSUS holds your most accurate inventory of patched machines. Select it from

the source list in the Add computers from wizard.

Settings

• Connection string - an OLE DB connection string that points to SUSDB. Any OLE DB provider for SQL

Server works; the supported providers are SQLOLEDB (the default), SQLNCLI11, and MSOLEDBSQL. The

button on the right of the field shows a hint listing the supported parameters (Provider, Server,

Database, Trusted_Connection, User ID, Password).

• Last contact (days) - filter out clients that have not contacted the WSUS server within the given number

of days. Default is 30; set to 0 to include every client regardless of last contact.

Sample connection strings

• Windows Internal Database (default install):

Provider=SQLOLEDB;Server=\\.\pipe\MICROSOFT##WID\tsql\query;Database=SUSDB;Trusted_Connection=Yes

• SQL Server Express on the WSUS server:

Provider=SQLOLEDB;Server=.\SQLEXPRESS;Database=SUSDB;Trusted_Connection=Yes

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-computers-using-the-wizard/
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• Remote SQL Server with integrated authentication:

Provider=SQLOLEDB;Server=sqlserver.domain.local;Database=SUSDB;Trusted_Connection=Yes

• Remote SQL Server with SQL authentication:

Provider=SQLOLEDB;Server=sqlserver.domain.local;Database=SUSDB;User

ID=wsususer;Password=secret

Requirements

• The account used to connect must have read access to SUSDB (the built-in WSUS Administrators

role is sufficient).

• The WSUS server (or the SQL Server hosting SUSDB) must be reachable from your management

machine.

Organizing computers into groups

Groups are folders inside the computer list. They have no effect on monitoring; they exist to keep large lists

navigable.

Creating a group

Choose Computers > Create new group... from the main menu, or right-click the computer list and pick

Create new group.... The Create new group dialog opens.

• Group name - the folder name. The same character restrictions that apply to computer names apply

here.

Click OK to create the group.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/adding-a-single-computer/
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Editing a group

Right-click the group and pick Edit, or select it and press the Edit toolbar button. The same dialog opens

with the title changed to Edit group and the current settings filled in.

Moving entries into a group

Drag any computer or group node and drop it onto a group in the tree. Drop onto empty space to move

items to the root level. Multi-selecting before you drag moves every selected item in one operation.

Removing a group

Right-click the group and pick Delete (or press Del with the group selected). Deleting a group also deletes

everything inside it, including all child groups, so the program asks you to confirm. Use Bulk operations >

Remove empty groups to clean up folders that have lost all of their children.

Bulk operations

The Bulk operations dialog applies one of nine maintenance actions to the computer list. Use it to clean up

after a long period of editing, to enforce a naming convention, or to reorganize an unwieldy list.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/bulk-operations/
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Opening the dialog

Choose Computers > Bulk operations... from the main menu.

Operation dropdown

The combo box at the top of the dialog chooses the action. Every operation has its own page of controls

below it; the page changes as you switch operations. The list below the controls (Affected items) shows a

live preview of what the operation will do, and a status label at the bottom reports how many items will be

affected.

Remove inactive computers

Removes all computers that are currently offline (not responding to ping). Nothing to configure. The preview

shows the entries that would be removed; review it before you click OK.

Remove duplicate computers

Finds entries with the same name (case-insensitive) and keeps the first occurrence in each duplicate group.

Nothing to configure.

Remove empty groups

Deletes all groups that contain no computers or subgroups. Nothing to configure.

Remove by pattern

Removes computers whose name matches a wildcard pattern.

• Pattern - the wildcard expression. Use * for any sequence of characters and ? for a single character.

Examples: TEST-*, *-OLD, PC-??.

Flatten group structure

Moves every computer to the root level and deletes all groups. Names are kept as-is.

Normalize computer names

Forces all computer names to a single capitalization style.

• Convert to - UPPERCASE, lowercase, or Title Case.

Rename computers

Inserts, removes, or replaces text in every computer name.

• Operation - Add prefix, Add suffix, Remove prefix, Remove suffix, or Replace text.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-state-verification/
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• Text - the text to add, the prefix or suffix to remove, or the substring to find when Replace text is

selected.

• Replace with - shown only when Replace text is selected. The text that the find string is replaced with.

Group computers

Builds new folders from a property of each computer.

• Group by - Name prefix, IP address / subnet, or Domain name.

• For Name prefix: a Segments spinner (1-10) controls how many leading segments (separated by -, _,

or .) make up the folder name. For example, with 2 segments SRV-DB-01 is grouped under SRV-DB.

• For IP address / subnet: choose a Subnet mask (/24 (255.255.255.0), /16 (255.255.0.0), or

/8 (255.0.0.0)) and a Format (192.168.x.x (Wildcard) or 192.168.0.0/16 (CIDR)).

Computer names must be IP addresses for this option.

• For Domain name: groups by the part of the name after the first dot (for example, PC1.sales.corp

ends up under sales.corp). No extra controls.

Format descriptions

Edits the description field of every computer in bulk.

• Operation - Set from template, Clear descriptions, Copy from name, Add prefix, Add suffix, or

Replace text.

• Filter - optional. A text or wildcard expression that limits the operation to computers whose name

matches. Leave blank to affect every computer.

• Template / Text / Find - the input field. Its label depends on the operation. Replace text also shows a

Replace with field.

• Only empty descriptions - tick this box to skip computers that already have a description.

The Set from template mode and the Add prefix / Add suffix modes accept placeholders: {name},

{prefix}, {prefix1}, {prefix2}, {suffix}, {desc}, {upper}, {lower}, {group}, {ip}, {mac}.

Using {ip} or {name} in the template triggers a background DNS/network lookup, and a spinner runs at

the bottom of the dialog while it works.

Preview pane

The Affected items list below the configuration shows what the operation will do. Columns adapt to the

operation: remove operations show a Name column and an Info column; rename, normalize, group, and

format operations add a Current and New column. Items being removed appear ghosted.

The status label at the bottom of the dialog reports the count (for example, 42 item(s) will be affected) or a

hint if the configuration is incomplete (Enter the pattern). For DNS-based templates the label updates as

items resolve.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/organizing-computers-into-groups/
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OK and Cancel

OK confirms the operation, then applies it to the list. The button is disabled while the preview is still being

built or when the configuration is invalid. Cancel closes the dialog without changing anything.

All bulk operations write to the computer list immediately and cannot be undone from within the dialog. If you

need a way back, save the list first using Importing and exporting the computer list.

Importing and exporting the computer list

Terminal Services Manager keeps the computer list in its own settings. Use the import and export

commands to save a copy as a file, share it with a colleague, or carry it between machines.

Exporting

Choose Computers > Export computer list from the main menu (it is the last item on the Computers

menu). A standard save-file dialog opens with a default name of the form computer_list_<timestamp>.

Pick the format from the Save as type dropdown:

• JSON (.json) - the default. Diffs cleanly in version control.

• XML (.xml) - useful when another tool you work with expects XML.

• Text (.txt) - one entry per line, name and description separated by | (the default delimiter). Easiest

format to edit by hand or generate from a script. Lines starting with # or // are treated as comments on

import.

• RHF (.rhf) - an XML-based "Radmin Host File" format, kept for compatibility and deprecated.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/importing-and-exporting-the-computer-list/
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Every export includes the full state of the list: computer names, descriptions, notes, the folder hierarchy,

expand and check state, and the favorite flag. The file also records its schema version so future versions of

the program know how to read it.

Importing

Choose Computers > Import computer list from the main menu. An open-file dialog appears that

recognizes all four formats above; the format is picked from the file extension.

After you select a file, a task dialog asks how to merge it with the list that is already loaded:

• Add new computers only - keep the current list; only computers that don't already exist are added. This

is the default and the safest option.

• Replace entire list - clear the current list, then load the file.

• Import all (allow duplicates) - add everything from the file even if some computers already exist.

If you change your mind after Replace entire list, exit Terminal Services Manager without confirming any

further changes - the loaded list is only persisted to disk when you exit normally.

Importing does not connect to any computer or test any credentials. Names go straight into the list as you

provide them.

Connection credentials

Terminal Services Manager talks to every computer - querying sessions, listing processes, opening a

server's dialogs - under the Windows account the program itself is running as. It does not store

per-computer or per-group credentials and does not prompt for a separate user name and password: every

request uses your current identity.

Managing servers that need a different account

When the account you are signed in with does not have rights on the target hosts (a different domain, or an

account without administrative access), run the program under an account that does:

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/organizing-computers-into-groups/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/connecting-with-alternate-credentials/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
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• Hold Shift, right-click tsmanager.exe (or its shortcut), choose Run as different user, and sign in with

an account that has rights on the Remote Desktop Services hosts; or

• Sign in to Windows with that account, or use a management workstation that already runs under it.

On a domain, the simplest setup is to run the program from an account that is a local administrator on the

RDS hosts you manage.

If a server shows access errors

Access denied or empty data from a server almost always means the account running the program lacks

rights on that host. Re-run the program under an account that has them.

Searching the computer list

The search field above the computer list is the fastest way to find an entry in a long list. As you type, every

entry whose displayed text does not contain what you typed is hidden.
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Where it is

The search field sits above the computer list pane on the left side of the main window, marked with a

magnifying-glass icon and the hint text Search string.

How matching works

• The match is a case-insensitive substring search against each item's displayed caption.

• The caption is built from the computer's name and description according to the Show computer caption

as style set in Preferences (default Computer name (Description)). With the default style, the search

therefore matches text from both fields. Switch to Computer name in Preferences if you want a strict

name search.

• Notes (the tooltip text shown on hover) and IP address columns are not part of the caption, so they are

not searched.

• Groups are filtered by the same rule as computers: a group whose own name does not contain the

search text is hidden, which also hides its children. To find entries inside a folder by name, type a

substring of the entry name and the matching entries become visible at their position; type the folder

name to keep the folder visible regardless of its content.

Clearing the search

A clear button (the small x icon) sits at the right edge of the field. Click it, or select all the text and press

Delete, to clear the search. The list reverts to showing every entry.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/computer-list-display/
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Tips

• The search affects only the computer list pane. The Servers, User sessions, and Processes tabs have

their own filters.

• Combine search with checkboxes to act on a subset: type to narrow the list, tick the entries you want,

then clear the search before invoking an action like bulk operations.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-overview/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/bulk-operations/
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Monitoring servers

The Servers tab watches every Remote Desktop Services host in your computer list at once. Each row is

one server, and the 29 columns show live CPU, memory, disk, network, RDP traffic, session counts, and

connection-quality numbers. It is the place to start when you want a single view of how all your hosts are

doing right now.

From the tab you can refresh the data on demand or on a timer, choose which columns to show, sort and

group the list, and export what you see to the clipboard or a CSV file. The right-click context menu adds

per-server actions such as connecting with Remote Desktop, opening management consoles, and shutting a

server down.

Use this section when you are setting up monitoring for the first time, when you want to know what a

particular column means, or when you need to get the current numbers out of the program and into a report.

In this section

• The Servers tab

• Server metrics reference

• Refreshing server data

• Configuring server columns

• Sorting and grouping servers

• Exporting server data

• Server context menu

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-context-menu/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-metrics-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/refreshing-server-data/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/configuring-server-columns/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/sorting-and-grouping-servers/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/exporting-server-data/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-context-menu/
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The Servers tab

The Servers tab lives on the right-hand pane of the main window. It shows one row per server in your

computer list, with live performance and session counters across 29 columns.

Layout

• Row - one Remote Desktop Services host. The leftmost column shows its name and description; the

remaining columns show metrics that update on a timer.

• Header - click a column heading to sort by that column; click again to reverse the sort order. Right-click

any heading to open the column header menu, where you can show or hide a column or open the

column settings dialog.

• Splitter - a horizontal bar separates the server tree from the graph panel below it. Drag the bar to give

more space to either pane.

Status icons

The name column shows a small icon next to each server. A colored icon means the last refresh succeeded;

a greyed-out icon means the server is unreachable. Hover the row to see the last error.

A computer that is not a Remote Desktop Services host (for example, a workstation listed for inventory)

reports its session and process counts as zero and most metrics stay blank. Use Configure Remote Desktop

from the context menu to turn a machine into an RDS host.

Selection

• Click a row to select that server. The graph panel below redraws to show its metrics.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/configuring-server-columns/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graphs-overview/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/enable-disable-remote-desktop/
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• Ctrl+click or Shift+click to extend the selection. Server actions (Refresh, Restart, and so on)

apply to every selected server.

• The checkbox at the start of each row is independent of selection. The graph series for a server is drawn

only while its checkbox is on.

See also

• Server metrics reference - what each column means

• Refreshing server data - how often the numbers update and how to force a refresh

• Server context menu - every right-click action

Server metrics reference

The Servers tab has 29 columns. They are grouped by category below. Use Configuring server columns to

hide the ones you do not need and reorder the rest.

Metrics tagged (graphable) can also be plotted on a chart from the graph panel; see Server metric graphs

reference for the full list and Choosing which metrics to graph for how to pick one.

Identity

• Server - the server name as it appears in the computer list, followed by the description if one is set. The

icon on the left shows whether the last refresh succeeded.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-context-menu/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-metrics-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/refreshing-server-data/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-context-menu/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/configuring-server-columns/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/server-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/server-metric-graphs-reference/
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CPU and memory

• CPU usage (graphable) - the percentage of CPU time consumed across all cores during the last refresh

interval.

• Memory usage (graphable) - physical memory currently in use. The number is formatted in KB, MB, or

GB based on its size and your preferences.

• Memory usage % (graphable) - memory usage as a percentage of installed RAM.

• Available memory (graphable) - physical memory not currently in use, formatted the same way as

memory usage.

• Pagefile usage % (graphable) - percentage of the page file currently committed.

Sessions and users

• Processes (graphable) - total number of processes running on the server across every session.

• Sessions (graphable) - total number of sessions on the server, including the console.

• Users (graphable) - total number of users logged on, regardless of state.

• Active users (graphable) - users whose session is currently active.

• Idle users (graphable) - users whose session is active but who have been idle for longer than the idle

threshold set in Preferences.

• Disconnected users (graphable) - users whose session is disconnected but still on the server.

RDP traffic

• RDP received rate (graphable) - traffic rate flowing from clients into the server across all RDP

connections. The number is formatted as bytes/s or bits/s based on your speed-unit preference.

• RDP send rate (graphable) - traffic rate flowing from the server out to clients, formatted the same way.

RDP connection quality

These metrics are averaged across the server's active RDP sessions and reflect what users actually

experience.

• Avg TCP RTT (graphable) - average round-trip latency between client and server, in milliseconds.

• Avg output FPS (graphable) - average number of screen-update frames the server sends per second.

• Avg input FPS (graphable) - average number of input frames the server receives per second.

• Avg frame quality (graphable) - average frame quality as a percentage. Lower values mean more

aggressive compression, usually a sign of constrained bandwidth.

• Connection quality (graphable) - median connection-quality score across active sessions, combining

latency, packet loss, and bandwidth.

Disk

• Disk free % (graphable) - free space on the system drive, as a percentage of the drive's capacity.

• Disk free (graphable) - free space on the system drive, formatted in KB, MB, or GB based on its size.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-settings/
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• Disk read speed (graphable) - read throughput on the system drive, formatted in bytes/s or bits/s.

• Disk write speed (graphable) - write throughput on the system drive, formatted the same way.

• Disk busy % (graphable) - the percentage of time the system drive was busy servicing requests during

the last refresh interval.

• Disk queue length (graphable) - the average number of read or write requests waiting in the system

drive's queue.

Network

• Network received (graphable) - inbound traffic rate across all network interfaces.

• Network sent (graphable) - outbound traffic rate across all network interfaces.

Uptime

• System uptime - how long the server has been running since its last restart.

Graph column

• Graph - a small sparkline for one metric per server. Use the graph panel and the column menu to

choose which metric to plot; see Choosing which metrics to graph.

See also

• Server metric graphs reference - the 26 metrics that can be plotted on the server graph, with units and

defaults.

Notes

• Numbers come from a mix of the Windows Terminal Services API, WMI (Win32_OperatingSystem

and related classes), and the Performance Data Helper (PDH) library. The first refresh after a server is

added often takes several seconds because PDH counters have to warm up; subsequent refreshes are

fast.

• A blank cell means the metric could not be read this time, or the value was zero. The most common

reasons for blank PDH-based columns are the Remote Registry service being stopped on the target, or

the current credentials lacking the required permission.

Refreshing server data

Terminal Services Manager refreshes server metrics on a timer. You can change how often that happens, or

trigger a refresh on demand.

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/choosing-which-metrics-to-graph/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/server-metric-graphs-reference/
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The auto-refresh timer

By default the program refreshes every server in the list every 10 seconds. The timer keeps running

whether the Servers tab is in front or not, so when you switch back to it you always see recent numbers.

Change the interval in File > Preferences, on the Terminal Services page:

• Automatically refresh server list every - the number of seconds between auto-refresh ticks. The

default is 10 seconds. Very low values are accepted, but anything below about 3-5 seconds risks starting

the next tick before slow servers have finished the previous one.

• Server response timeout - the number of seconds the program waits for a single server to respond

before giving up. The default is 30 seconds and the allowed range is 10 to 300 seconds.

Refreshes run in parallel: each server is queried on its own worker thread, so a slow or unreachable host

does not hold up the others. The number of worker threads is also set in WTS options.

Manually refreshing selected servers

Select one or more servers, then right-click and choose Refresh server from the server context menu. Only

the selected servers are queried.

Refreshing every server

Right-click in the Servers tab and choose Refresh all servers. Every entry in the list is queued for refresh

immediately, regardless of selection.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-settings/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-context-menu/
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Tuning for large fleets

If your environment is large and the default 10-second interval pushes too much WMI and PDH traffic,

lengthen the interval to 30 or 60 seconds; the graphs still build a useful history, just sampled less often. For

a specific incident, drop the interval to a few seconds while you investigate, then put it back when you are

done.

A server that is repeatedly slow to refresh usually has either WMI throttling enabled or the Remote Registry

service stopped. The row's tooltip reports which check failed.

Configuring server columns

The Servers tab ships with 29 columns, which is more than fits on most screens. Use the column settings

dialog to hide the ones you do not need, reorder the rest, and set the width and alignment of each.

Opening the dialog

Right-click any column header on the Servers tab and choose Column settings.... A modal dialog opens

with a list of every available column.

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graphs-overview/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/


Terminal Services Manager - Terminal Services Manager handbook

What the dialog does

• List - one row per column. The checkbox controls visibility; the order in the list is the order on the tab.

• Up / Down buttons - rearrange the selected column.

• Show / Hide buttons - turn the selected column on or off.

• Column width - the width in pixels for the selected column.

• Alignment - left, right, or center alignment for the selected column.

Changes apply to the tab in real time, so you can see the effect immediately.

The main column

The first column on the tab (the server name) is the main column. It cannot be hidden and cannot be

moved out of first position. Other columns have no such restriction.

OK and Cancel

Click OK to keep your changes. Click Cancel to revert to the column layout that was in place when you

opened the dialog. Layout changes are saved with the program's settings and survive restarts.

Related dialogs

The same column settings dialog is used for the User sessions and Processes tabs. Layouts are stored

separately for each tab. The Application log tab has a fixed set of four columns (Time, Level, Category,

Message) and does not use this dialog.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/configuring-user-columns/
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Sorting and grouping servers

The Servers tab is a flat list, but the column header lets you control how it is ordered.

Sorting by a column

Click a column heading to sort the list by that column. An arrow appears in the heading to show direction:

• Up arrow - ascending (A to Z, 0 to highest, oldest to newest).

• Down arrow - descending.

Click the same heading again to flip the direction. Click a different heading to sort by that column instead.

The tab sorts on one column at a time.

Reading the sort

When a sort is active, the order updates after every refresh tick. A server whose CPU just spiked moves up

the list automatically. If that is too distracting, sort by Server (which does not change between refreshes) for

a stable ordering.

Grouping

The Servers tab is a flat tree; it does not support arbitrary grouping. The closest thing is the grouping you set

up in your computer list (see Organizing computers into groups); the Servers tab shows whatever is in the

computer list.

For ad-hoc grouping during incident response, sort by the metric that matters (for example, Connection

quality) and read down the list.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/organizing-computers-into-groups/
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Quick navigation

• Home / End - jump to the first or last row.

• Type a letter - jump to the next row whose name starts with that letter.

• Up / Down arrows - move the selection by one row.

Search across the entire computer list is available in the left pane (see Searching the computer list). The

Servers tab itself does not have its own search field.

Exporting server data

There are two ways to get server data out of Terminal Services Manager: copy it to the clipboard, or save it

as a CSV file.

Copying to the clipboard

The Copy submenu of the Servers context menu has three commands:

• Copy row - the focused row, all visible columns, as tab-separated text. Paste it into a spreadsheet or a

message.

• Copy cell - just the cell under the mouse pointer. Useful for quoting a specific number.

• Copy all rows - every visible row, all visible columns, including a header row. The data goes to the

clipboard as tab-separated text.

Hidden columns are not included. Sort order in the clipboard matches what you see on screen.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/searching-the-computer-list/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-context-menu/


Terminal Services Manager - Terminal Services Manager handbook

Exporting to a CSV file

Choose Servers > Export servers to CSV from the main menu. A save-file dialog opens with a default

name of the form servers-YYYY-MM-DD-HH-MM-SS.csv.

The export contains:

• One row per visible server.

• One column per visible column on the Servers tab, in the current order.

• A header row with the column titles.

CSV is the only export format. The file opens directly in Excel and any text editor. On locales where the

comma is the decimal separator, configure Excel's import to treat commas as field separators and dots as

the decimal mark, or open the file through Data > From Text/CSV instead of double-clicking.

What gets exported

The exported data is a snapshot of the screen at the moment you press Export: the same columns, the

same sort order, the same visible rows. Hidden columns are not in the file; checkbox state is not in the file. If

you need a different shape (for example, just the slow servers), sort and filter the view first, then export.

The exported file is a one-time snapshot. For continuous monitoring, point a script at the same WMI

counters and PDH paths directly.

Server context menu

Right-clicking a row on the Servers tab opens the server context menu. Every command operates on the

selected servers (which may be more than one if you held Ctrl or Shift while clicking).

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
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Connection

• Remote desktop - open a Remote Desktop session to the server using the standard Windows client.

• Send message to all users - opens the send message dialog, which broadcasts the message to every

user logged on to the selected servers.

Session actions on every user

• Disconnect users - drop the connection of every user on the server. Their session stays on the server in

the disconnected state; they can reconnect to it later.

• Disconnect idle users - same as above, but only for users whose session has been idle longer than the

configured threshold.

• Log off users - end every user's session and discard it. Unsaved work is lost.

• Log off idle users - log off only the users whose session has been idle longer than the threshold.

• Log off disconnected users - log off only the users whose session is currently disconnected.

Each of these asks for confirmation before it runs.

Administration submenu

• Users activities - opens the Users activities viewer for the selected server.

• Failed logons - opens the failed logons viewer.

• Session history - opens the session history viewer.

• User profiles - opens the user profiles manager.

• Remote Desktop Services properties... - opens the RDS properties editor.

• Remote Desktop Services licenses... - opens the RDS licensing dialog.

• Configure Remote Desktop... - opens the enable/disable Remote Desktop dialog.

Tools submenu

The Tools submenu lists custom command-line tools you have registered (see Custom command-line

tools). The submenu is empty until you add at least one tool.

Drill-down

• Show users - switches to the User sessions tab and shows only the users on the selected servers.

• Show processes - switches to the Processes tab the same way.

Power

• Restart server - restart the selected servers. Opens a simple confirmation dialog (see Rebooting and

shutting down).

• Power off server - shut down the selected servers. Same confirmation flow.

https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/connecting-via-remote-desktop/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/sending-a-message/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rds-event-log/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/failed-logons/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/session-history/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/user-profiles/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rds-properties/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rds-licensing/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/enable-disable-remote-desktop/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/custom-command-line-tools/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/custom-command-line-tools/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/the-processes-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rebooting-and-shutting-down/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rebooting-and-shutting-down/
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Refresh

• Refresh server - refresh just the selected servers.

• Refresh all servers - refresh every entry in the computer list.

Copy

The Copy submenu has three commands, all of which write to the clipboard as tab-separated text:

• Copy row - the focused row, all visible columns.

• Copy cell - just the cell under the mouse pointer.

• Copy all rows - every visible row, with a header row at the top.

Details

• Details... - the last item on the menu. Opens the Entity details dialog for the focused server, showing

every metric with minimum, average, and maximum values and a chart. Double-clicking a server row

does the same.

https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/entity-details/
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Managing user sessions

The User sessions tab is where you see every user logged on to every server in your list, with one row per

session. Alongside each user it shows session state, performance counters, client details, and connection

quality, so you can tell at a glance who is active, who is idle, and who is using the most resources.

From here you can act on a session directly: disconnect a user without ending their work, log them off, reset

a stuck session, shadow their screen to help with a problem, or send them a message before maintenance.

You can also pick which columns to show and export the list to the clipboard or a CSV file.

Use this section when you need to manage who is connected, free up resources on a busy host, or step in

to support a user. It explains the tab, every column, and every action on the context menu.

In this section

• The User sessions tab

• User session metrics reference

• Disconnecting a user

• Logging off a user

• Shadowing a user

• Sending a message

• Message presets

• Resetting a session

• Configuring user columns

• Exporting user data

• User context menu

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/user-session-metrics-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/disconnecting-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/logging-off-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/shadowing-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/sending-a-message/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/message-presets/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/resetting-a-session/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/configuring-user-columns/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/exporting-user-data/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/user-context-menu/
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The User sessions tab

The User sessions tab is the second tab in the right-hand pane. Each row is one user session on one

server. The 44 available columns cover identity, performance, RDP connection quality, client information,

session timing, and a per-session sparkline graph.

Layout

• Row - one session. Multiple sessions of the same user on different servers are listed as separate rows.

• Header - click a column heading to sort by it. Right-click for the column-header menu.

• Splitter - a horizontal bar between the session tree and the graph panel below it. Drag to resize.

Status icons

The leftmost column shows the session state:

• A green icon means the session is active (the user is connected and interacting with it).

• A gray icon means the session is disconnected (the user closed the client but the session is still on the

server).

• A red icon means a problem state (reset in progress, listening, init, idle exceeding the limit).

Hover the icon for the exact state string.

Selection

• Click to select a session. The graph panel below redraws for that session.

• Ctrl+click or Shift+click extends the selection. Actions apply to every selected session.

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graphs-overview/
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• The checkbox at the start of each row is independent of selection.

See also

• User session metrics reference

• User context menu

User session metrics reference

Every column on the User sessions tab is listed below. Use Configuring user columns to choose which ones

you see.

Metrics tagged (graphable) can also be plotted on a chart from the graph panel; see User session metric

graphs reference for the full list and Choosing which metrics to graph for how to pick one.

Identity

• User - the login name. For local accounts, the bare user name; for domain accounts, just the user name

(the domain is in the next column).

• Domain - the domain or computer that authenticated the account.

• Server - the server the session is on.

• Host / Farm - the RDS session host and the deployment name, when the server is part of an RDS farm.

Session

• Session ID - the numeric session ID on the server. Session 0 is the services session; 1 is normally the

console.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/user-session-metrics-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/user-context-menu/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/user-session-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/user-session-metric-graphs-reference/
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• Session - the WinStation name (RDP-Tcp#N, Console, services).

• State - active, disconnected, idle, listening, init, reset, down, shadow, conn, conn query, others.

CPU and memory

• CPU usage (graphable) - percentage of total CPU time consumed by every process in the session

during the last refresh interval.

• Memory usage (graphable) - working set across all processes, in megabytes.

• Memory usage % (graphable) - working set as a percentage of installed RAM.

• Processes (graphable) - number of processes running in the session.

• Handles (graphable) - total OS handles open across the session's processes.

• Threads (graphable) - total threads.

Session timing

• Logon time - when the session was created.

• Connect time - when the user most recently connected to the session.

• Disconnect time - when the user most recently disconnected.

• Last input time - when input was last received from the client.

• Idle time - elapsed time since the last input.

• Session duration - elapsed time since logon, regardless of connect state.

• Connected time - elapsed time since the most recent connect.

RDP traffic

• RDP received rate (graphable) - bytes per second from the client into the server on this session.

• RDP send rate (graphable) - bytes per second from the server to the client.

RDP connection quality

Reported by the RDP stack for this session. Values are blank when the session is disconnected.

• TCP RTT (graphable) - latency between client and server in milliseconds.

• TCP bandwidth (graphable) - bytes per second of available bandwidth as estimated by the stack.

• Output FPS (graphable) - frames sent to the client per second.

• Input FPS (graphable) - frames received from the client per second.

• Frame quality (graphable) - average compression quality. Lower values mean more aggressive

compression.

• Loss rate (graphable) - packet loss percentage.

• Retransmission rate (graphable) - percentage of packets retransmitted.

• FEC rate (graphable) - forward error correction overhead percentage.

• Frames skipped (client) (graphable) - frames the client could not render in time.

• Frames skipped (network) (graphable) - frames dropped on the wire.
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• Frames skipped (server) (graphable) - frames the server skipped before sending.

• Encoding time (graphable) - milliseconds spent encoding the last frame batch.

• Connection quality (graphable) - overall grade combining latency, loss, and bandwidth.

Client

• Client name - the host name reported by the client.

• Client address - the IPv4 or IPv6 address the client connected from.

• Client type - a derived RDP and OS version string for the client (for example, "RDP 8.1, Windows 8.1 /

Server 2012 R2").

• Client display - the client's display resolution and color depth.

• Client directory - the install path of the client (when reported).

• Work directory - the working directory configured for the session.

• Initial program - the program configured to run on logon, when set.

Graph column

• Graph - a sparkline of the metric you have chosen for this session.

See also

• User session metric graphs reference - the 21 metrics that can be plotted on the user-session graph, with

units and defaults.

Notes

• Sessions on servers that fail to refresh do not show up here. They appear when the next refresh

succeeds.

• Performance metrics that depend on PDH counters (CPU, memory percent, handles, threads) need the

Remote Registry service running on the server.

Disconnecting a user

Disconnect closes the user's RDP connection but leaves the session on the server. The user can connect

again later and find their work where they left it.

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/user-session-metric-graphs-reference/
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How to do it

Select one or more sessions on the User sessions tab, then:

• Right-click and choose Disconnect, or

• Choose Users > Disconnect from the main menu.

A confirmation dialog asks Are you sure you want to disconnect all selected users?. Click Disconnect

to proceed.

What happens on the server

The Windows API call WTSDisconnectSession runs on each target server. The session state changes to

Disconnected. The user sees their RDP client window close; any unsaved work in open applications is

kept.

A disconnected session continues to consume memory and CPU. If you also want to free those resources,

log the user off instead.

Common reasons it does not work

• The account running the program lacks the Disconnect session privilege on the target server. Adjust

the user's permissions in the RDS session host configuration, or run the program under an account that

has it.

• The session is in a transient state (init, listening, reset). Wait for it to settle and try again.

See also

• Logging off a user

• Resetting a session

Logging off a user

Log off ends the user's session and discards it. The user has to sign in again to start a fresh session. Any

unsaved work is lost.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/logging-off-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/connecting-with-alternate-credentials/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/logging-off-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/resetting-a-session/
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How to do it

Select one or more sessions, then:

• Right-click and choose Log off, or

• Choose Users > Log off from the main menu.

A confirmation dialog asks Are you sure you want to log off all selected users?. Click Log off to

proceed.

What happens on the server

The Windows API call WTSLogoffSession runs on each target server. The session ends. Applications in

the session receive their normal session-end notifications; whatever they had unsaved is gone unless they

autosave. If the user is still connected when you log them off, they see their RDP window close.

Tell the user before you log them off if you can. Use Send a message to give them a few minutes to save

their work.

Disconnect vs log off vs reset

• Disconnect keeps the session and the apps; the user can resume later.

• Log off and Reset both call the same Windows WTSLogoffSession API and end the session. Pick

Log off for normal cleanup of a finished user and Reset for sessions that have to go now (see Resetting

a session). The user-facing effect is the same; the labels exist to keep the two intents separate in muscle

memory and in the audit log.

See also

• Disconnecting a user

• Resetting a session

• Sending a message

Shadowing a user

Shadow opens a remote-control window on the user's session. You see what they see; depending on the

options, you can also share their keyboard and mouse. The connection runs over RDP and uses the

standard Microsoft mstsc.exe client.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/sending-a-message/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/resetting-a-session/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/resetting-a-session/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/disconnecting-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/resetting-a-session/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/sending-a-message/
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How to do it

Select one session on the User sessions tab, then:

• Right-click and choose Shadow, or

• Choose Users > Shadow from the main menu.

The Shadow dialog opens.

Shadow options

• View - watch the session without taking input. Sometimes labeled view-only.

• Control - share keyboard and mouse with the user.

• Prompt for user consent - when ticked, the user sees a confirmation prompt and the shadow only starts

after they accept. When cleared, the shadow starts without prompting. Whether unprompted shadowing

is permitted depends on the server's group policy and the user's permissions; see the RDS properties

dialog and the local Set rules for remote control of Remote Desktop Services user sessions policy.

Whether the shadow window spans multiple monitors is not set here; it follows the program's Connect with

/multimon option setting on the Terminal Services preferences page.

Click OK to start the shadow. Terminal Services Manager launches mstsc.exe with the appropriate

/shadow, /control, /noConsentPrompt, and (when that option is enabled) /multimon flags. Close

the mstsc.exe window to end the shadow.

Requirements

• The account used to connect must be an administrator on the target server (default policy) or must be

listed in the Remote control permission on the RDS session host configuration.

• The server must be Windows Server 2012 R2 or later. Earlier versions used a different shadow

mechanism with no view/control distinction.

• The client machine must have mstsc.exe with shadow support (Windows 8.1 and later).

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rds-properties/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rds-properties/
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When shadow fails

• Access denied - the connecting account does not have permission. Add it under Remote control in the

session host configuration, or add it to the local Administrators group.

• The session is not in a connectable state - the user is logging off, has been reset, or the session is

still initializing. Try again in a few seconds.

• The user declined the prompt - they clicked No on the consent dialog. Talk to them, then retry.

Sending a message

Send message displays a Windows message box on the user's session. Use it to warn users before a

reboot, ask them to log off, or tell them about a problem you are about to fix.

How to do it

Select one or more sessions on the User sessions tab, then:

• Right-click and choose Send message, or

• Choose Users > Send message from the main menu.

You can also send a message to every user on a whole server: right-click the server on the Servers tab and

choose Send message to all users.

The Send message dialog opens.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
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Fields

• Title - the message-box title.

• Message body - the text shown in the message box. Multi-line.

• Message type - the icon shown in the message box: None, Info, Warning, or Error. Each comes with its

own system sound.

• Close message after - tick this box, then enter a number and pick a unit (seconds, minutes, hours). The

message box closes on its own after that time if the user does not dismiss it. With the box unticked, the

message stays until the user clicks OK.

The recipient line at the top of the dialog says exactly who the message will go to: a specific session, every

session on a server, every session on a list of servers, and so on.

Variable substitution

The title and body support placeholders. They are replaced just before the message is sent. Five tokens are

recognized:

• %computer_name% - the local computer name of the machine running Terminal Services Manager.

• %user_name% - the user name of the operator running Terminal Services Manager.

• %date% - the current date.

• %time% - the current time.

• %time_now% - the current date and time as a single string.

Variable names are case-insensitive. Per-recipient tokens (recipient user, server, session ID, client name)

are not supported; the message text is the same for every recipient on a multi-target send.

Sending

Click Send message to send. The dialog blocks until every send has finished. The recipient sees the

message immediately. Their OK click is not reported back to Terminal Services Manager; if you need a

reply, ask the user to contact you separately.

The arrow next to the Send message button offers extra actions:
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• Preview message (Ctrl+Shift+Enter) - show the message box on your own screen to check the

wording before sending.

• New message (Ctrl+N) - clear the form to start a fresh message.

• Add message to presets (Ctrl+Alt+Enter) - save the current title, body, and type as a preset for

one-click reuse.

See also

• Message presets - save common messages for one-click reuse

Message presets

A preset is a saved message you can apply with one click. Presets are organized into categories.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/message-presets/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/message-presets/
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Opening the preset manager

The preset manager opens from the Send message dialog. Click the menu (hamburger) button to the left of

the message-type dropdown on that dialog, then choose Manage presets. The Manage presets window

opens with a tree of categories on the left and the items in the selected category on the right.
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Adding a category

Click Add category. Type a name and click OK. Categories are flat; they do not nest.

Adding a preset

Select the category and click Add item. The Create preset dialog opens with these fields:

• Preset name - what the preset is called in the menu. Required.

• Title - the message-box title used when this preset is applied.

• Message - the message text. The same %computer_name%, %user_name%, %date%, %time%, and

%time_now% placeholders described in Sending a message are substituted at send time.

• Message type - None, Info, Warning, or Error.

Editing, deleting, and reordering

Select a preset or category and use the toolbar buttons or context menu to Edit, Remove, or Up / Down.

You can also drag items between categories. Deleting a category also deletes every preset inside it; the

manager asks to confirm.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/sending-a-message/


Terminal Services Manager - Terminal Services Manager handbook

Import, export, and reset

The menu (hamburger) button on the Send message dialog also offers Import presets, Export presets,

and Reset to defaults commands. Import and export work on the whole preset tree as a single file; reset

replaces the tree with the shipped defaults.

Applying a preset

Click the preset button on the Send message dialog. A popup menu opens listing categories as submenus

and presets as their items. Click a preset to load its title, body, and type into the dialog. Edit the timeout or

text if you need to, then click OK to send.

Storage

Presets are kept in the program's SQLite database along with other settings. They survive program restarts

and travel with the configuration backup.

Resetting a session

Reset terminates the session immediately. Unlike log off, it does not give the session's applications a

chance to close cleanly. Use it when log off has hung or when a session is stuck in a bad state.

How to do it

Select one or more sessions, then:

• Right-click and choose Reset, or

• Choose Users > Reset session from the main menu.

A confirmation dialog asks Are you sure you want to reset sessions for all selected users?. Click Reset

to proceed.



Terminal Services Manager - Terminal Services Manager handbook

What happens on the server

The Windows WTSLogoffSession API runs on the target server, the same call used by Log off. The

session is removed; any application that had not already saved its work loses it. The session disappears

from the list on the next refresh.

This is the same as the reset session command in query session / tsadmin parlance. The label

"Reset" exists in the menu so you can keep mental separation between "the user is finished" (Log off) and

"the session is stuck and needs to go" (Reset), even though the underlying Windows API is the same.

When to use it

• Log off has been running for several minutes with no effect.

• The session is in Idle, Down, or another non-responsive state and you need to free the slot.

• A session-specific service is hung and the user cannot reconnect.

For normal cleanup of a finished user, prefer Log off. Reset is the emergency escape hatch.

Configuring user columns

The User sessions tab ships with 44 columns. Use the column tuning dialog to pick the ones you want and

hide the rest.

Opening the dialog

Right-click any column header on the User sessions tab and choose Column settings....

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/logging-off-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
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What the dialog does

• List - one row per available column. The checkbox controls visibility. The order in the list is the order on

the tab.

• Up / Down - reorder the selected column.

• Show / Hide - turn the selected column on or off.

• Column width - the width in pixels for the selected column.

• Alignment - left, right, or center alignment.

Changes apply to the tab live as you make them.

The main column

The first column on the tab is the user name. Keep it visible and in position 1 so each row stays identifiable;

the other 43 columns can be reordered or hidden freely.

OK and Cancel

OK keeps your changes. Cancel reverts to what was in place when you opened the dialog. The layout is

saved with the program's settings.

The same dialog is used for the Servers and Processes tabs. Each tab has its own layout stored separately.

The Application log tab has a fixed set of four columns (Time, Level, Category, Message) and does not use

this dialog.

Exporting user data

You can copy session data to the clipboard or export it as a file.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/configuring-server-columns/
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Copying to the clipboard

The Copy submenu of the User context menu has three commands:

• Copy row - the currently focused row, all visible columns, as tab-separated text.

• Copy cell - just the cell under the mouse pointer.

• Copy all rows - every visible row plus a header row.

Hidden columns are not included.

Exporting to a file

Choose Users > Export users to CSV from the main menu. A save-file dialog opens with a default name

based on users. CSV is the only file format the export produces; the dialog's extension filter is .csv.

The file is a snapshot of the screen: the visible columns in their current order, sorted as the screen is sorted.

Hidden columns are not in the file. For other formats, open the CSV in Excel, LibreOffice, or your editor of

choice and save from there.

User context menu

Right-click any row on the User sessions tab to open this menu. Every command operates on the selected

sessions.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/user-context-menu/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
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Connection

• Connect - start a Remote Desktop connection to the focused session's server using the focused

session's user name. The program prompts for the user's password and launches mstsc.exe. Use this

for picking up a disconnected session as that user.

• Disconnect - drop the connection, keep the session on the server.

• Send message - opens the send message dialog for the selected sessions.

• Shadow - opens the shadow dialog for the focused session.

Diagnostics

• User activity - opens the user-activity log filtered to this user (see Session history).

• Failed logons - opens the failed logons viewer filtered to this user.

• Session history - opens the full session history viewer for the user's server.

Session control

• Reset - terminate the session immediately.

• Log off - end the session.

Both commands ultimately call the Windows WTSLogoffSession API; the difference is the confirmation

prompt and the recommended use (see Resetting a session).

https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/connecting-via-remote-desktop/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/disconnecting-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/sending-a-message/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/shadowing-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/session-history/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/failed-logons/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/session-history/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/logging-off-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/resetting-a-session/
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Drill-down

• Show processes - switches to the Processes tab filtered to the focused session.

• Show server - switches to the Servers tab and selects the host.

Copy

• Copy row - the focused row.

• Copy cell - the cell under the mouse pointer.

• Copy all rows - every visible row with a header.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/the-processes-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
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Managing processes

The Processes tab lists every process running on every server in your list. Each row is one process on one

server in one session, so you can see at a glance who owns what and how much it is consuming. When a

server slows down, this is where you find the cause: sort by CPU or memory to surface the heaviest

process, check the user session that owns it, and stop it if you need to.

The tab shows 15 data columns plus a graph column, covering process identity, CPU and memory use,

threads, and handles. You decide which columns appear and in what order, and you can plot the graphable

metrics on a chart. A filter strip above the tree narrows the list to the processes you care about, and the

context menu gives you the actions: terminate, copy details, jump to the owning session, and more.

This section walks through the tab itself, the full metrics reference, how to terminate a process, filtering,

column layout, exporting to the clipboard or a CSV file, and the context menu.

In this section

• The Processes tab

• Process metrics reference

• Terminating a process

• Filtering processes

• Configuring process columns

• Exporting process data

• Process context menu

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/process-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/process-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/the-processes-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/process-metrics-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/terminating-a-process/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/filtering-processes/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/configuring-process-columns/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/exporting-process-data/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/process-context-menu/
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The Processes tab

The Processes tab is on the right-hand pane of the main window. Each row is one process running on one

server in one session. Across the 15 data columns plus the graph column you can see identity (name, PID,

owner), CPU and memory usage, threads, and handles.

Layout

• Row - one process. Processes are not aggregated by name; if notepad.exe runs in three sessions

you see three rows.

• Header - click to sort, right-click for the column-header menu.

• Filter panel - the strip above the tree holds a quick search, a filter chip area, and a presets menu. See

Filtering processes.

• Splitter - separates the process tree from the graph panel below it. Drag to resize.

Selection

• Click to select. The graph panel below redraws for the selected process.

• Ctrl+click or Shift+click extends the selection. Actions apply to every selected process.

See also

• Process metrics reference

• Process context menu

https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/main-window/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/filtering-processes/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graphs-overview/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/process-metrics-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/process-context-menu/
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Process metrics reference

The Processes tab has 15 data columns plus a graph column, grouped by category below. Use Configuring

process columns to choose which ones you see.

Metrics tagged (graphable) can also be plotted on a chart from the graph panel; see Process metric graphs

reference for the full list and Choosing which metrics to graph for how to pick one.

Identity

• Process name - the executable's image name (for example, notepad.exe). PID 0 is shown as System

idle process.

• PID - the numeric process ID assigned by the operating system on the host where the process runs.

Unique per server, not across servers.

• Server - the server the process lives on.

• Session ID - the numeric user session the process belongs to.

• User - the account the process runs under (DOMAIN\user). Blank when the owner cannot be resolved.

• User SID - the security identifier of the user account, as a string.

CPU

• CPU usage (graphable) - percentage of total CPU time consumed by the process during the last refresh

interval.

• CPU time - total CPU time consumed by the process since it started.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/configuring-process-columns/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/configuring-process-columns/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/process-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/process-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/


Terminal Services Manager - Terminal Services Manager handbook

Memory

• Memory usage (graphable) - the working set: pages currently held in physical memory by the process.

Formatted in KB, MB, or GB based on its size.

• Memory usage % (graphable) - working set as a percentage of installed RAM on the server.

• Peak memory usage - the largest working set the process has held since it started.

• Pagefile usage (graphable) - bytes the process has committed to the page file, formatted the same way

as working set.

• Peak pagefile usage - the largest pagefile commit the process has held since it started.

Resources

• Threads (graphable) - number of threads the process currently has.

• Handles (graphable) - number of OS handles currently open by the process.

Graph column

• Graph - a sparkline of the metric you have chosen for this process. The available metrics are CPU

usage, working set, memory usage %, pagefile usage, threads, and handles.

See also

• Process metric graphs reference - the 6 metrics that can be plotted on the process graph, with units and

defaults.

Notes

• CPU usage and most other numbers come from PDH counters on the target server. Servers with

Remote Registry disabled often report blank or zero values.

• The same process appears once per server. To see every instance of chrome.exe across your fleet,

sort by Process name or use Filtering processes.

Terminating a process

Terminate stops the process immediately, without giving it a chance to save state or warn its user. Use it

when a process is consuming runaway resources or has hung.

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/process-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/filtering-processes/
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How to do it

Select one or more processes on the Processes tab, then either:

• Right-click and choose Terminate process, or

• Choose Processes > Terminate process from the main menu.

A confirmation dialog appears. Click Terminate to proceed. The dialog also has a Terminate all processes

with this name checkbox (worded in the plural when several processes are selected); tick it to terminate

every process that shares the same name, not just the ones you selected.

What happens on the server

The Windows API call WTSTerminateProcess(handle, pid, 0) runs against each selected process

on its host server. Buffers are not flushed, file handles are closed by the OS without giving the process a

chance to write final data, and no logoff prompt appears for the user whose session the process was in.

A success log entry is written for each terminated process; failures are logged with the Win32 error

message. Check the Application log tab if a termination did not work as expected.

Common reasons a termination fails

• Access denied - the current connection credentials do not have the right to terminate that process on

that server. System and other elevated processes always require admin privileges on the target.

• The process has already exited between the time you selected it and the time the action ran. The row

disappears on the next refresh.

Multi-server selection

Selecting processes across several servers is allowed. The confirmation dialog applies to the entire

selection; each process is terminated against its own server.

See also

• Process context menu for other actions that operate on the session that owns the process

https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/the-application-log-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/connecting-with-alternate-credentials/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/process-context-menu/
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Filtering processes

The Processes tab has a filter strip above the tree. Use it to narrow the list to the processes you care about.

Quick search

The text field on the left is a substring search. As you type, rows that do not contain the search text in any of

their visible text columns are hidden. Matching text is highlighted in the cells.

Click the clear button at the right edge of the field to remove the search.

Filter conditions

Use the filter chip area to add conditions. The Filter builder opens when you choose Custom filter... from

the presets menu. Each condition is one field, one operator, and one value (for example, CPU usage >

50). Active conditions are shown as chips below the search field; click a chip to edit it, or click its x to

remove it.

Presets

A preset is a saved set of conditions. Click the presets button to open a menu of:

• Built-in and custom presets - click one to toggle it on or off. Built-in presets ship with the product and

cover common cases such as high CPU, high memory, and system processes.

• Custom filter... - opens the filter builder for the current query.

• Clear filter - removes every active condition and the quick search.

• Manage presets... - opens the preset manager.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/quick-search/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/building-a-filter/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/built-in-presets/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/saved-presets/
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• Advanced > Export presets... and Import presets... - save or load preset files.

• Advanced > Reset to defaults - replace your presets with the built-in set.

Where this all lives

The same filter mechanics work on the Servers, User sessions, and Processes tabs, each with its own field

list. See Filtering and searching for the full reference.

Configuring process columns

The Processes tab ships with 15 data columns plus the graph column. Use the column settings dialog to

pick the ones you want.

Opening the dialog

Right-click any column header on the Processes tab and choose Column settings....

What the dialog does

• List - one row per available column. The checkbox controls visibility. The order in the list is the order on

the tab.

• Up / Down - reorder the selected column.

• Show / Hide - turn the selected column on or off.

• Column width - the width in pixels for the selected column.

• Alignment - left, right, or center alignment.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/the-processes-tab/
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Changes apply to the tab as you make them.

The main column

The first column on the tab (the process name) cannot be hidden and cannot be moved out of first position.

OK and Cancel

OK keeps your changes. Cancel reverts to the layout that was in place when you opened the dialog. Layout

changes are saved with the program's settings.

The same dialog is used for the Servers and User sessions tabs. Each tab has its own layout stored

separately. The Application log tab has a fixed set of four columns (Time, Level, Category, Message) and

does not use this dialog.

Exporting process data

You can copy process data to the clipboard or save it as a CSV file.

Copying to the clipboard

The Copy submenu of the Process context menu has three commands:

• Copy row - the focused row, all visible columns, as tab-separated text.

• Copy cell - just the cell under the mouse pointer.

• Copy all rows - every visible row, plus a header row.

Hidden columns are not included. If a filter is active, only the rows that pass the filter are copied.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/process-context-menu/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/filtering-processes/
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Exporting to a CSV file

Choose Processes > Export processes to CSV from the main menu. A save-file dialog opens with a

default name of the form processes-YYYY-MM-DD-HH-MM-SS.csv.

CSV is the only export format. The file opens directly in Excel and any text editor.

The export is a snapshot: the visible columns in the current order, sorted as the screen is sorted, only the

rows that pass any active filter.

Process context menu

Right-click any row on the Processes tab. Every command operates on the selected processes, or on the

session and server that own the focused process.

Process action

• Terminate process - stop the selected processes (see Terminating a process).

Session of the process

These commands act on the session that owns the focused process, not on the process itself.

• Remote desktop - open an RDP session to the server.

• Shadow user - shadow the session that owns the process (see Shadowing a user).

• Disconnect user - disconnect that session.

• Log off user - log off that session.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/terminating-a-process/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/connecting-via-remote-desktop/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/shadowing-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/disconnecting-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/logging-off-a-user/
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• Reset session - reset that session.

• Send message - send a message box to that session.

Server of the process

• Restart server - restart the server hosting the process.

• Shut down server - shut it down.

Drill-down

• Show user processes - switches to the Processes tab filtered to every process of the same user.

• Show user session - switches to the User sessions tab and selects the owning session.

• Show server - switches to the Servers tab and selects the host.

Copy

• Copy row - the focused row, all visible columns.

• Copy cell - the cell under the mouse pointer.

• Copy all rows - every visible row, with a header row at the top.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/resetting-a-session/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/sending-a-message/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
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Filtering and searching

The Servers, User sessions, and Processes tabs each have a filter strip above the data tree. The strip

combines three tools: a quick search for typing a substring, a builder for compound conditions, and saved

presets you apply with a click. The same mechanics work on all three tabs, so once you learn the filter on

one tab you know it everywhere. Only the set of fields you can filter on changes from tab to tab.

Quick search is the fastest way in: type part of a name and the list narrows as you go, with matches

highlighted. When you need more than a substring match, the builder lets you compose conditions out of a

field, an operator, and a value, and combine several of them. Anything you build can be saved as a preset

and pinned to the strip as a button, and the program ships with a useful set of presets on each tab.

This section covers the overview of the strip, quick search, building a filter, the fields available on each tab,

the operators, how to save and manage your own presets, and the built-in presets.

In this section

• Filter overview

• Quick search

• Building a filter

• Filter fields reference

• Operators reference

• Saved presets

• Built-in presets

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-overview/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/quick-search/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/building-a-filter/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-fields-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/operators-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/saved-presets/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/built-in-presets/
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Filter overview

The filter strip sits between the tab caption and the data tree. It has the same shape on every tab. From left

to right:

• A quick search field for substring matches.

• A Filter button that opens the filter builder.

• A row of preset buttons for one-click filters - the presets that have the Show as button flag.

• A presets menu button for everything else: the rest of the presets, Custom filter, Manage presets, and

an Advanced submenu with import, export, and reset to defaults.

• Active conditions appear below as chips, with a single All match / Any match label shown once when

two or more chips are present.

• A clear filter button on the right edge removes everything.

The status line on the right of the tab caption shows how many rows are visible out of how many total, so

you can see at a glance how much your filter has narrowed the list.

How conditions combine

Every active condition (whether typed into the builder, restored from a preset, or set by clicking a chip) joins

the others using a single logical operator. The default is All match; click the All match / Any match label on

the chip strip to flip the whole filter. There is no mixed AND / OR in one filter; switch to Any match if you

need any of several conditions to match.

The quick search is always combined with the conditions using AND: a row must match the quick search

AND satisfy the filter condition tree.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/quick-search/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/building-a-filter/
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Three tabs, three field lists

Each tab has its own set of fields:

• Servers: 27 fields covering CPU, memory, sessions, RDP traffic, disk, network, and connection quality.

• User sessions: 32 fields covering identity, session state, CPU and memory, idle and connection timing,

RDP traffic, and per-session connection quality.

• Processes: 15 fields covering identity, CPU, memory, page file, threads, and handles.

See Filter fields reference for the full list per tab.

What survives a restart

Active conditions, the quick-search text, and which presets are toggled on are saved with the program's

settings and restored on next launch. Saved presets and the order they appear in are also persisted (see

Saved presets).

Quick search

The quick search is the text edit at the start of the filter strip. It matches a substring of the row's identifying

text. Use it when you know the name (or part of it) and want to narrow the list immediately.

How matching works

• The match is case-insensitive.

• Match runs on a fixed set of identity columns per tab:

• Servers tab: server name and server description.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-fields-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/saved-presets/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-overview/
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• User sessions tab: user name, domain, server name, session name, host name, client name, and client

address.

• Processes tab: process name, user name, server name, user SID, process ID, and session ID (numeric

fields are stringified, so typing 1234 matches PID 1234 and session 1234).

• Matched characters are highlighted in the cell with a light yellow background, so you can see which part

of the cell matched.

The match field list is fixed for each tab. If you need to search a column the quick search does not cover (a

session client name, a session state, a process PID), use the filter builder with the appropriate field and the

contains operator.

Debounce and clear

Filtering does not fire on every keystroke. The program waits 300 milliseconds after you stop typing before

applying the filter, so a long search string does not redraw the tree on every character.

A clear button (the small x icon) appears at the right edge of the field as soon as you type one character.

Click it to clear the search. The keyboard shortcut Esc with the field focused does the same.

Quick search and other conditions

The quick search is independent of the filter builder. You can have both an active quick search and a set of

conditions at the same time; rows must match the quick search AND satisfy the condition tree to be visible.

The visible-row counter on the right of the tab caption reflects both.

Per-tab placeholder

Each tab uses its own placeholder text in the field to remind you what the quick search will match. For the

User sessions tab, the placeholder is the typical fields it searches; same for the others. The placeholder is

only a hint; the actual match scope is documented above.

Building a filter

The filter builder lets you compose conditions out of a field, an operator, and a value. Use it when the quick

search is not enough, when you need a numeric threshold, or when you want to combine several conditions.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/building-a-filter/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/quick-search/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/quick-search/
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Opening the builder

Click the Filter button on the filter strip. A small popup opens where you set one quick condition - a field, an

operator, and a value - and click Apply.

For several conditions, AND / OR logic, or saving the filter as a preset, click Advanced... in that popup. The

full Filter builder dialog opens. If conditions already exist on the tab they are loaded so you can edit them;

otherwise the dialog starts with one empty row.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/saved-presets/
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Adding and removing conditions

• Click Add condition at the bottom of the row list to add another condition. Each condition is one field,

one operator, one value (or two values, for Between).

• Click the x at the right of a row to remove that condition.

There is no hard limit on how many conditions you can stack.

A single AND or OR for the whole filter

The builder has one logical-operator dropdown for the whole condition list, not one per row. The choice

(AND or OR) applies to every condition in the dialog. If you need mixed logic (for example, cpu > 80 OR

(memory > 70 AND processes > 200)), nest by creating one preset for the OR group and one for the

AND group, then use them together; the builder does not nest.

Field combo

The field combo lists every field for the current tab. See Filter fields reference for the full set. Picking a field

updates the operator combo to show only the operators that make sense for that field's type:

• String fields (names, addresses, states) offer contains, excludes, begins with, ends with,

equals, not equals.

• Numeric fields (CPU, memory, counts, times) offer equals, not equals, greater than, less

than, between.

See Operators reference for what each operator does.

Value field

The value field changes shape depending on the chosen field and operator:

• For text fields: a plain text edit.

• For numeric fields: a number edit with a unit selector. For sizes the units are KB, MB, GB, TB; for speeds

B/s, KB/s, MB/s, GB/s; for time seconds, minutes, hours, days; for percentages just %.

• For the Between operator on numeric fields: two value edits with and between them, both with their own

unit selectors.

The default unit for each field matches the unit shown in the column on the data tab.

Save, save as..., cancel

The dialog has three buttons:

• OK applies the conditions to the active tab.

• Save as... opens a small prompt for a name and a description, then adds the preset to the current tab's 

preset list. The builder dialog stays open after saving so you can still tweak conditions and click OK when

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-fields-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/operators-reference/
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you're ready, or save more variants. The Show as button toolbar flag is not set at save time; toggle it

later from Manage presets.

• Cancel discards your changes and leaves the tab's existing filter alone.

OK is disabled while any row is incomplete (no field, no value, or invalid value).

Quick edits without opening the builder

Each chip on the filter strip is editable: click the chip to reopen the builder pre-loaded with that condition, or

click the chip's x to drop it. The All match / Any match label on the chip strip is also clickable and toggles

the whole filter between the two modes.

Filter fields reference

Each tab has its own set of fields available in the filter builder. The fields below are grouped by category.

The unit shown is the default; for numeric fields you can switch to a different unit in the builder's value edit.

Server fields

Available on the Servers tab.

Identity

• Server (text) - server name as it appears in the computer list.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/building-a-filter/
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Performance

• CPU usage (%) - server-wide CPU.

• Memory usage (MB) - committed memory.

• Memory % (%) - committed memory as a fraction of installed RAM.

• Available memory (MB) - physical memory not in use.

• Pagefile usage % (%) - page file commit fraction.

• System uptime (sec) - how long since the server booted.

Sessions and users

• Processes - process count across all sessions.

• Users - logged-on user count.

• Active users - currently active.

• Idle users - active but idle longer than the threshold.

• Disconnected users - session present but client disconnected.

RDP traffic

• RDP received rate (B/s) - aggregate inbound RDP bytes per second.

• RDP send rate (B/s) - aggregate outbound.

Disk

• Disk free % (%) - free space on the system drive.

• Disk free (MB) - same as megabytes.

• Disk read speed (B/s) - bytes per second read.

• Disk write speed (B/s) - bytes per second written.

• Disk busy % (%) - time the disk was busy servicing requests.

• Disk queue length - queued I/O requests.

Network

• Network received (B/s) - inbound across all interfaces.

• Network sent (B/s) - outbound across all interfaces.

RDP connection quality (aggregated across sessions)

• Avg TCP RTT (ms) - round-trip latency, averaged.

• Avg output FPS (fps) - server-to-client frame rate.

• Avg input FPS (fps) - client-to-server frame rate.

• Avg frame quality (%) - average frame quality.

• Connection quality (%) - median connection quality across active sessions.
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User session fields

Available on the User sessions tab.

Identity

• User name (text)

• Domain (text) - domain or computer that authenticated the account.

• Server (text) - host the session is on.

• Host (text) - RDS session host.

• Farm (text) - RDS deployment.

• Session ID - numeric session ID.

• Session (text) - WinStation name.

• State (text) - active, disconnected, idle, etc.

Performance

• CPU usage (%) - session-wide CPU.

• Memory usage (MB) - working set across the session's processes.

• Memory % (%) - as a fraction of installed RAM.

• Processes - count.

• Handles - OS handles open across the session.

• Threads - threads in the session's processes.

Session timing

• Idle time (sec) - time since last user input.

• Session duration (sec) - since logon.

• Connected time (sec) - since most recent connect.

Client

• Client name (text) - hostname the client reports.

• Client address (text) - client IP.

RDP traffic

• RDP received rate (B/s)

• RDP send rate (B/s)

RDP connection quality

• RTT (ms) - round-trip latency.

• Output FPS - server-to-client frame rate.

• Input FPS - client-to-server frame rate.
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• Connection quality (%) - overall grade.

• Loss rate (%) - packet loss.

• Retransmission rate (%) - retransmitted packets.

• FEC rate (%) - forward-error-correction overhead.

• Frames skipped (client) - frames the client could not render in time.

• Frames skipped (network) - frames dropped on the wire.

• Frames skipped (server) - frames the server skipped before sending.

• Encoding time (ms) - server-side encode time per frame batch.

Process fields

Available on the Processes tab.

Identity

• Process name (text) - executable image name.

• Process ID - PID.

• Server (text) - host the process runs on.

• Session ID - session the process belongs to.

• User name (text)

• User SID (text)

CPU and memory

• CPU usage (%)

• CPU time (sec) - total CPU consumed since the process started.

• Working set (MB) - resident memory.

• Memory % (%) - working set as a fraction of installed RAM.

• Peak working set (MB) - largest working set held since start.

• Pagefile usage (MB) - committed pagefile.

• Peak pagefile (MB) - largest committed pagefile since start.

Resources

• Threads - thread count.

• Handles - OS handles open.

Notes

• Numeric values are entered in the unit you pick in the builder; internally the filter compares in a

normalized unit (KB for sizes, B/s for speeds, seconds for time), so picking GB vs MB does not change

the result.

• A field that the server cannot read this refresh (for example, Memory % when Remote Registry is 

stopped) is treated as zero by the filter engine. Conditions that depend on such a field may include or
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exclude that row unexpectedly until the next successful refresh.

Operators reference

The filter builder offers nine operators in total. Which ones appear in the operator combo depends on the

type of the field you picked.

String operators

Available when the field is text (names, addresses, states).

• contains - the value is a substring of the field, case-insensitive. The most common choice.

• excludes - the value is not a substring. Useful for ignoring patterns (process name excludes

svchost).

• begins with - the field starts with the value.

• ends with - the field ends with the value.

• equals - exact match, case-insensitive.

• not equals - any value other than the supplied one.

Wildcards are not interpreted. Type notepad to match notepad.exe, not notepad*.

Numeric operators

Available when the field is numeric (counts, percentages, sizes, speeds, times).

• equals - equal to the supplied value.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-fields-reference/
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• not equals - any value other than the supplied one.

• greater than - greater than the supplied value.

• less than - less than the supplied value.

• between - inclusive range. The builder shows two value edits with and between them. The lower bound

goes first; if you reverse them the filter still matches the inclusive range.

Greater than or equal and less than or equal are not separate operators. To express >= 50,

use greater than 49 for integers, or between with the same lower and upper bound.

Unit conversion

Numeric operators compare in a normalized unit:

• Sizes are normalized to KB.

• Speeds are normalized to B/s.

• Time is normalized to seconds.

• Percentages are kept as-is.

Picking a different unit in the builder's value edit (for example, Memory > 4 GB vs Memory > 4096 MB)

does not change the match. The unit is only a display convenience.

Default operator per field

When you switch the field in the builder, the operator combo resets to a sensible default:

• String fields default to contains.

• Numeric fields default to greater than.

You can change to any compatible operator after picking the field.

Combining conditions

Operators apply to a single condition. The logical operator that combines all conditions (AND or OR) is set

once for the whole filter, not per condition. See Building a filter for how to switch it.

Saved presets

A preset is a saved filter you can apply with one click. Presets are scoped to one tab; a server preset is not

visible on the Processes tab.

Where presets appear

• As toolbar buttons on the filter strip, when the preset has the Show as button flag set. These are for

the filters you reach for most often.

• In the presets menu (the button next to the toolbar preset buttons), where every preset for the current

tab is listed.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/building-a-filter/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-overview/
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A preset name on a toolbar button doubles as a toggle: click to apply, click again to remove. You can have

several toolbar presets toggled on at the same time; their conditions combine with the active condition tree

using the same single AND / OR logical operator.

Creating a preset

Open the filter builder, set up the conditions you want, then click Save as.... A small input dialog asks for:

• Name - what the preset is called in the menu and on the button.

• Description - shown as the tooltip.

Save also applies the preset to the current tab. To make the preset appear on the toolbar, set the Show as

button flag later from the preset's Edit dialog or from Manage presets.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/building-a-filter/
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Managing presets

Open Manage presets from the presets menu. The Manage filter presets dialog opens with the list of

presets for the current tab. From there you can:

• Add... - opens the builder in preset mode for a new preset.

• Edit... - reopens the builder with the selected preset loaded.

• Remove - delete the selected preset (after confirmation).

• Up / Down - reorder. The order controls both menu order and toolbar button position.

• Drag and drop - reorder by dragging within the list.

A preview pane below the list shows the selected preset as a stack of chips so you can see what conditions

it carries without opening the builder.

Import and export

The presets menu has an Advanced submenu with Export presets and Import presets commands. Export

writes every preset for the current tab to a single JSON file. Import reads the same format back in and asks

how to handle duplicates:

• Skip duplicates - keep existing presets unchanged; only new names are added.
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• Replace existing - overwrite presets that share a name; everything else is added.

Either way, brand-new presets are appended at the end of the list. After the import a small dialog

summarizes how many were imported, replaced, skipped, or errored.

Use export to back up your presets or share them with another machine; import to restore them.

Reset to defaults

Reset to defaults is the last item in the Advanced submenu. It opens a task dialog with three choices:

• Keep custom presets - re-add the shipped defaults next to your custom presets, replacing any

default-named ones that were edited.

• Remove all - delete every preset on the current tab and load only the shipped defaults. Use with care;

custom presets are gone.

• Cancel - do nothing.

Back custom presets up with export first if you plan to use Remove all.

Where presets are kept

Presets are stored in the program's SQLite settings database. They survive program restarts and are

scoped per tab type (process, session, server). Three separate lists exist, one per tab.

Built-in presets

The program ships with a set of presets ready to use on each tab. They are loaded on first run and

re-loaded whenever you pick Reset to defaults. Presets marked as toolbar are shown as buttons on the

filter strip; the rest live only in the presets menu.

https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/built-in-presets/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/filter-overview/
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Server presets

Preset Condition Where

High CPU (>80%) CPU usage > 80 toolbar

High Memory (>80%) Memory % > 80 toolbar

Many Users (>10) Users > 10 menu

Overloaded (>90%)
CPU usage > 90 OR Memory %

> 90
toolbar

Poor Connection (<50%) Connection quality < 50 toolbar

User session presets

Preset Condition Where

Active Users State contains "Active" toolbar

Disconnected Users
State contains

"Disconnected"
toolbar

Current User
User name contains <your

account>
toolbar

High CPU (>50%) CPU usage > 50 menu

High Memory (>100MB) Memory usage > 100 MB menu

Idle Users Idle time > 5 minutes toolbar

Poor Connection (<25%) Connection quality < 25 toolbar

Degraded Connection (<50%) Connection quality < 50 menu

Packet Loss (>1%) Loss rate > 1 menu

Network Trouble
Loss rate > 1 OR

Retransmission rate > 5
menu
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Process presets

Preset Condition Where

High CPU (>50%) CPU usage > 50 toolbar

High Memory (>100MB) Working set > 100 MB toolbar

User Processes Session ID > 0 toolbar

System Processes Session ID = 0 toolbar

Many Handles (>1000) Handles > 1000 menu

Many Threads (>50) Threads > 50 menu

Current User
User name contains <your

account>
toolbar

High Memory (>500MB) Working set > 500 MB menu

Active Processes CPU usage > 0 menu

Current-user substitution

The Current User presets (on the Processes and User sessions tabs) substitute the running Windows user

name at the moment the preset is loaded. Switching Windows users restarts the program and re-resolves

the substitution.

Modifying built-ins

You can edit a built-in preset like any other saved preset. Your edit persists. Reset to defaults restores the

shipped version (and discards every custom preset on the same tab). To keep both, copy the built-in to a

new preset under a different name, edit the copy, and leave the original alone.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/the-processes-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/filtering-and-searching/saved-presets/
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Server administration tools

The dialogs and actions in this chapter let you do administration tasks against a remote Remote Desktop

Services host without leaving Terminal Services Manager: open a Remote Desktop session, reboot or shut

the host down, toggle RDP on or off, inspect RDS properties and licenses, manage user profiles, browse

session history, read failed-logon and RDS activity events, and run your own command-line tools. Each one

opens its own dialog from the server context menu or the Servers main menu.

Most of these live under the Administration submenu of the server context menu:

The first group is about reaching and controlling the host itself. Remote desktop opens an interactive

mstsc.exe session to the selected server, and the Connect action does the same as a specific user

without retyping the password. Restart server and Power off server run a confirmed reboot or shutdown

across every selected server. Configure Remote Desktop turns RDP on or off, with options to update the

Windows Firewall rules and log off active users first.

The next group reads and edits the server's Remote Desktop Services configuration. The Remote Desktop

Services properties dialog shows remote-control policy, security, client redirection, and session timeouts,

with the editable pages saved over WMI. The Remote Desktop Services licenses dialog lists the RDS

client access licenses (CALs) installed on a licensing server, including how many seats are issued,

available, and about to expire.

The remaining tools are for cleanup, auditing, and your own shortcuts. User profiles enumerates and

deletes profiles across one or more servers. Session history, Failed logons, and Users activities

reconstruct logon, logoff, and failed-sign-in events from the Windows event logs, each with its own export

and report options. Custom command-line tools runs external programs and PowerShell one-liners

against the selected computer or session, and the Details dialog shows every tracked metric for one server,

session, or process with a chart for the focused value.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-context-menu/
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In this section

• Connecting via Remote Desktop

• Rebooting and shutting down

• Enabling or disabling Remote Desktop

• RDS properties

• RDS licensing

• User profiles

• Session history

• Failed logons

• Users activities

• Custom command-line tools

• Entity details

Connecting via Remote Desktop

The Remote desktop action opens an interactive RDP session to the selected server using the standard

Microsoft client (mstsc.exe).

https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/connecting-via-remote-desktop/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rebooting-and-shutting-down/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/enable-disable-remote-desktop/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rds-properties/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rds-licensing/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/user-profiles/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/session-history/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/failed-logons/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rds-event-log/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/custom-command-line-tools/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/entity-details/
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How to do it

Select one server on the Servers tab, then:

• Right-click and choose Remote desktop, or

• Choose Servers > Remote desktop from the main menu.

A new mstsc.exe window opens connected to the server's hostname or IP from the computer list entry. If

the entry has explicit credentials stored, they are passed to the client; otherwise Windows handles the

credentials prompt as usual.

Connecting from a user session

The User sessions tab also has a Connect action on the row's context menu. Use it when you want to start

a new Remote Desktop session as a specific user without typing the password into the standard Windows

credential prompt.

What you see:

1. A small dialog asks for the password for the selected user account.

2. After you confirm, there is a brief pause and then mstsc.exe opens against the server.

3. You are signed in as that user; no separate credential prompt appears.

What happens under the hood:

• The program briefly saves the user name and the password you entered as a Windows generic

credential for TERMSRV/<server>, using the cmdkey command. This is the same store the Remote

Desktop client looks at when it needs credentials for a server.

• It then launches mstsc.exe /v:<server> (with /multimon if Connect with /multimon option is

enabled in the Terminal Services preferences). mstsc picks up the stashed credential automatically and

signs in.

• About five seconds later the program deletes that stored credential with cmdkey /delete, so the

password does not stay in the Windows Credential Manager after the session is launched. The RDP

window itself keeps running until you close it.

Notes:

• This action always opens a brand-new session for the selected account. It does not reconnect to or

attach to the row's existing session ID; for that, use Shadowing below.

• The same Connect action is available on the Processes tab and behaves the same way, using the

account that owns the selected process.

To shadow a running session instead of opening a new one, use Shadowing a user.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-settings/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/shadowing-a-user/
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Connecting to a specific user session

From the User sessions tab, use the Connect action on the row's context menu (described above) to open

an RDP session as the selected user. On the Processes tab, the Remote desktop action on a process row

opens an RDP session to the row's server using the standard mstsc.exe flow.

What this is not

Terminal Services Manager does not embed an RDP client. The session runs in the standard Microsoft

mstsc.exe window; closing that window ends the session. Settings such as full-screen, multi-monitor, drive

redirection, and clipboard sharing are taken from the saved .rdp profile or the current mstsc.exe

defaults; they are not configurable from this program.

Rebooting and shutting down

Terminal Services Manager can restart or power off a monitored server. Both actions ask for a simple

confirmation first, then run against every selected server.

How to do it

Select one or more servers on the Servers tab, then:

• Right-click and choose Restart server or Power off server, or

• Choose Servers > Restart server or Servers > Power off server from the main menu.

A confirmation dialog appears for the action you picked.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
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Click Restart or Power off to go ahead, or Cancel to abort. When more than one server is selected, the

prompt says how many. The request is then queued and carried out on each server; watch the Application

log for the result.

Warn users first

There is no message field on these prompts. If you want to warn users before the action, send a message

first with Sending a message or a message preset.

To log a user off rather than restart the whole server, use the per-session Log off action on the User

sessions tab instead.

Common reasons it fails

• The account running the program lacks the Shut down the system privilege on the target. Adjust the

user's permissions, or run the program under an account that has it.

• The server is unreachable, or is already powering off or restarting from an earlier request.

Enabling or disabling Remote Desktop

This dialog turns Remote Desktop Services on or off on the selected server. Use it to bring a freshly-built

server into the program's coverage, or to lock down a server you no longer want reachable over RDP.

https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/the-application-log-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/the-application-log-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/sending-a-message/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/logging-off-a-user/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/connecting-with-alternate-credentials/
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How to do it

Right-click the server on the Servers tab and choose Administration > Configure Remote Desktop.... The

Remote Desktop dialog opens with the server's current state loaded.

Options

Two radio buttons under Remote Desktop status set the target state:

• Allow remote connections to this computer - users can connect remotely using Remote Desktop.

• Don't allow remote connections to this computer - users cannot connect remotely. Active sessions

are preserved unless you also turn on the log-off switch below.

Two toggle switches under Options modify the action:

• Update Windows Firewall rules for Remote Desktop - when on, the Remote Desktop firewall group

is enabled or disabled to match the chosen state.

• Log off all users when disabling Remote Desktop - when on, every active session on the target is

logged off after Remote Desktop is disabled, so nobody is left on a host that no longer accepts new

connections.

What happens on the server

The action makes WMI calls against the target. It calls the SetAllowTSConnections method on

Win32_TerminalServiceSetting, passing the chosen state and the firewall flag in one call, then logs

off active sessions if that option is switched on. A small activity indicator and status label at the bottom report

progress.

Errors are reported as Win32 reasons; the most common is Access denied when the connecting account

lacks administrator rights on the target.

RDS properties

The Remote Desktop Services properties dialog displays a subset of the Remote Desktop Services

configuration on a server. Only the Remote control tab is editable; Security, Client settings, and Session

timeouts are read-only. For settings the dialog doesn't expose, use the Group Policy editor or the RDS

deployment console.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
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How to open it

Right-click the server on the Servers tab and choose Administration > Remote Desktop Services

properties....

Tabs

The dialog has four pages selected from a list on the left.

Remote control

Picks the policy the server applies to incoming shadow requests. Five radio buttons:

• Disable remote control - users can't remotely control or view other users' sessions.

• Full control with user's permission

• Full control without user's permission

• View only with user's permission

• View only without user's permission

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/shadowing-a-user/
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A Controlled by policy label appears in the top-right of the tab when Group Policy is enforcing the setting;

in that case the radio buttons are greyed out.

Changes are applied via WMI when you click OK.

Security

Read-only. Three values:

• Security layer - for example Negotiate, RDP, or SSL/TLS.

• Encryption level - for example Low, Client compatible, High, or FIPS compliant.

• Certificate - the certificate currently in use, or Not configured.
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Client settings

Read-only. Five toggle switches show the current client feature redirection state, plus one color depth value:

• Drive redirection

• Clipboard redirection

• Printer redirection

• Audio redirection

• COM port redirection

• Color depth - for example 32-bit (Highest quality).

The toggles reflect the server's current settings but can't be changed here. A Controlled by policy label

appears when Group Policy locks the tab.
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Session timeouts

Read-only limits, in minutes. Each value shows No limit when nothing is enforced.

• Active session limit - end an active session after this much time.

• Disconnected session limit - drop a disconnected session after this much time.

• Idle session limit - disconnect an idle session after this much time.

The bottom toolbar has Refresh to re-read values from the server, plus OK and Cancel.

RDS licensing

The RDS licensing dialog lists the Remote Desktop Services client access licenses (RDS CALs) installed

on the selected licensing server. Use it to see how many seats are issued, how many are available, and

which key packs are about to expire.
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How to open it

Right-click the server on the Servers tab and choose Administration > Remote Desktop Services

licenses....

The dialog opens a connection to the RDS licensing role on the target. The server you pick must have the

licensing role installed; on a session host without licensing you will see an error.

Header

Three read-only values at the top:

• License server - the licensing server reported by the target. Shows Not configured when the target has

no licensing server set.

• Grace period - one of three states: Active (no grace period) when the licensing role is fully activated, N

days remaining (in red) while the role is still in its grace window, or Expired (in red) once the window

has elapsed.

• Summary - totals across every visible key pack, written as N total, N issued, N available (the sums of

the Total, Issued, and Available columns).

Columns

• Product - the Windows version the licenses apply to (for example, Windows Server 2022).

• Type - the key pack type: Retail, Volume, Concurrent, or Open.

• Total - seats in the key pack.

• Issued - seats currently handed out to clients.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
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• Available - seats still free (Total minus Issued).

• Expiration - date the key pack expires; permanent packs leave the cell blank.

• Status - an icon indicating the pack's health (OK, info, warning, or error).

• Description - the key pack's display name from the licensing console.

Actions

• Export to file - save the visible list to a file.

• Refresh - re-query the licensing server (also bound to F5).

• Close - dismiss the dialog.

The context menu adds Copy selected (Ctrl+C) and Copy all, which write the chosen rows to the clipboard

as tab-separated text.

Column order, width, and sort direction are saved with the program's settings.

What it does not do

The dialog is read-only. To install, activate, or revoke licenses, use the Remote Desktop Licensing

Manager console on the licensing server itself.

User profiles

The User profiles dialog enumerates the user profiles present on one or more servers and lets you delete

the ones you no longer need. Use it to clean up after staff turnover, recover space taken by abandoned

profiles, or audit who has logged on to a server.
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How to open it

Right-click one or more servers on the Servers tab and choose Administration > User profiles. The dialog

queries every selected server in parallel.

Columns

• User - the account that owns the profile.

• Server - the host the profile lives on.

• Status - Local, Roaming, Mandatory, Temporary, or Corrupted.

• Loaded - Yes if the profile is currently in use by a logged-on user; profiles in this state can't be deleted.

• Health - profile health status as reported by Windows. Hidden by default; turn it on from the header

context menu.

• Local Path - the on-disk path (typically C:\Users\<name>).

• Last Use - the time the profile was last loaded.

• Size - disk space the profile occupies.

Filtering

The filter panel at the top right has two controls:

• Profiles - a dropdown that limits the list to one profile type at a time: all (default), local, temporary,

roaming, mandatory, or corrupted.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
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• Inactive - a number paired with a unit dropdown (hours, days, weeks, months [default], years).

Profiles used more recently than this threshold are hidden. Set the number to zero to disable the filter.

Actions

The bottom toolbar:

• Export to file (Ctrl+E) - writes the visible list to a file.

• Report... - opens a report-export dialog and writes an HTML report.

• Delete (Del) - removes the selected profiles after a confirmation dialog. Loaded profiles and special

system or service profiles are skipped; for a loaded profile the user has to log off first. Mandatory profiles

can be deleted; the central template is not touched.

• Close - dismiss the dialog.

The context menu adds Open (Ctrl+O) to launch the profile path in Windows Explorer, Refresh (F5) to

re-query the selected servers, Select all (Ctrl+A), and the standard copy actions.

What it does not do

The dialog does not migrate profiles, archive them, or reset their Health status. For those operations use the

User Profiles Control Panel applet on the target server.

Session history

The Session history dialog reconstructs past logon, logoff, disconnect, and reconnect events for a server

(or one user across a server) by reading the Windows event log. Use it to answer "who was on this box

yesterday between 9 and 11", to audit access, or to compare typical activity across days.
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How to open it

• Right-click a server on the Servers tab and pick Administration > Session history to see every session

on the server in the chosen period.

• Right-click a user on the User sessions tab and pick Session history to see that user's sessions across

the server.

The first time you open the dialog on a server, the program reads the

Microsoft-Windows-TerminalServices-LocalSessionManager/Operational log and stitches together

logon/logoff pairs. The reads run in the background; a progress indicator shows the current event being

processed.

Time range

The toolbar at the top of the dialog has a Period dropdown of common ranges plus two date pickers. Pick a

preset to set both pickers automatically, or set the pickers directly for a custom range, then click Fetch to

reload the table.

Columns

• User - the account that signed in.

• State - whether the session was active, disconnected, or completed by the end of the period.

• Session ID

• Logon time - when the session was created.

• Logoff time - when it was destroyed (blank for sessions still active).

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
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• Duration - logoff minus logon.

• Active time - time the session spent in the active state (excluding disconnected periods).

• Disconnects - how many times the user disconnected during this session.

• Client address - last known client IP.

Filter

The User field at the top of the dialog filters the table by user name; wildcards (*, ?) are supported. Press

Enter in the field to apply.

Export

The bottom toolbar:

• Export CSV - tabular dump of the current view.

• Report... - opens a report-export dialog and writes an HTML report with summary analytics (sessions per

user, hourly distribution, peak concurrent sessions).

Both buttons are enabled only when there's data to export. The context menu adds Copy selected (Ctrl+C)

and Copy all.

What it does not do

Session history is built from the Windows event log; if the log has been cleared or has rolled over, the

corresponding history is lost. The program does not replay logon/logoff events from any other source.

Failed logons

The Failed logons dialog reads the Security event log on a server and lists every event with ID 4625 (an

account failed to log on). Use it to spot brute-force attempts, find account-lockout causes, or audit a specific

user's failed sign-ins.
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How to open it

• Right-click a server on the Servers tab and choose Administration > Failed logons to see every failed

logon on the server in the chosen period.

• Right-click a user on the User sessions tab and choose Failed logons to see only that user's failures.

Time range

The same toolbar as Session history: a Period dropdown of presets and two date pickers, then Fetch to

reload. The dialog opens with Today selected by default.

Columns

• Event - human-readable event description (Logon failed).

• Time Created - when the event was recorded.

• User - the account that failed to log on.

• Address - the source IP, when present.

• Failure Reason - the failure description derived from the NTSTATUS code and sub-status, followed by

the status code in hex. Typical values: Unknown user name or bad password, User logon with

account locked, User logon with expired account, User logon outside authorized hours, User

logon from unauthorized workstation.

The failure reason combines the Status and SubStatus fields of the 4625 event into a single readable

string.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/session-history/
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Filter

A User field at the top of the dialog filters by user name (wildcards * and ? supported). Press Enter to

apply.

Export

The bottom toolbar:

• Export CSV - the visible rows as comma-separated text.

• Report... - opens a report-export dialog and writes an HTML report with counts per user, per source IP,

and per failure reason.

The context menu adds Copy selected, Copy all, and Refresh (F5).

What this is not

The dialog only reads the local Security log of the target server. Network-edge devices, RD Gateway logs,

and Active Directory domain-controller logs are not consulted; if a brute-force attempt is being thwarted at

the gateway, you will not see it here.

Users activities

The Users Activities dialog lists every Terminal Services session event recorded on a server. It names the

common events - logon, logoff, disconnect, and reconnect - and shows any other event type by its numeric

event ID. It is the chronological view of session activity, in contrast to Session history which folds events into

one row per session.

https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/session-history/
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How to open it

• Right-click a server on the Servers tab and choose Administration > Users activities.

• Right-click a user on the User sessions tab and choose User activity to see only that user's events.

Time range

The same toolbar as the other event viewers: a Period dropdown of presets and two date pickers, then

Fetch to reload. Opens with Today by default.

Columns

• Event - the event description, derived from the Terminal Services event ID. Recognized values: Logon,

Logoff, Disconnected, Reconnected. Unknown IDs are shown as their numeric value.

• Time Created - when the event was recorded.

• User - the account associated with the event.

• Address - the client IP, when the event records one.

The events come from the Microsoft-Windows-TerminalServices-LocalSessionManager/Operational

log.

Filter

A User field with wildcard support narrows the list to one account. Press Enter to apply.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
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Export

The same two buttons as the other event viewers: Export CSV writes the visible rows as comma-separated

text, and Report... writes an HTML report with summary analytics (logon / logoff / disconnect / reconnect

counts, unique users).

When to use which viewer

• Session history when you want to know how long sessions lasted, how often a user disconnected, and

the active vs. disconnected time per session.

• Failed logons when you are investigating brute-force or account-lockout activity.

• Users activities when you need the raw event chronology, including events that do not pair into

sessions (orphan disconnects, server-side logoffs, session resets).

Custom command-line tools

The Tools menu on the main menu bar (and the Tools submenu on the server context menu) is built from a

customizable list of tools grouped into categories. Each entry runs an external program with the selected

computer or session details substituted into the parameters. Out of the box the list includes a curated set of

admin shortcuts; you can edit those, remove them, or add your own, so the categories and counts on your

machine may differ from the screenshot and the default list below.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-context-menu/
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Where the tools come from

The list is stored in the program's SQLite settings as a tree of categories and tools, seeded on first run from

a shipped commands.sql file (and re-seeded on Reset to defaults). The Tools menu rebuilds itself when

the list changes; no restart is needed.

Opening the manager

Choose Tools > Manage tools from the main menu. The Manage tools dialog opens with a category tree

on the left and details on the right.

Editing the list

Buttons on the toolbar:

• Add category - prompts for a name; the new category appears at the bottom.

• Add item - opens the editor for a fresh entry inside the focused category.

• Edit - opens the editor on the selected entry.

• Remove - removes the selected category or tool after confirmation. Removing a category removes every

tool inside it.

• Up / Down - move the selected entry up or down to reorder it.

Tools can be reordered within a category with the Up / Down buttons or by drag and drop, and moved

between categories by drag and drop.
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Tool editor

The Create tool / Edit tool dialog has these fields:

• Tool name - what the menu shows.

• Command type - the kind of action the entry runs. Standard external programs use the default type;

built-in actions (see below) use their own types and hide the program-name and parameters fields.

• Program name - the executable to run. A ... button next to the field opens a file picker.

• Shell operation - which Windows ShellExecute verb to invoke (open by default; runas triggers a UAC

elevation prompt; other verbs depend on what's registered for the file type).

• Parameters (optional) - command-line arguments. Supports variable substitution; see below.

• Working directory (optional) - the directory the process runs in. A ... button opens a folder picker.

• Icon - pick an icon from a built-in collection; the icon is shown next to the menu item.
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Variable substitution in parameters

Parameters are substituted just before the process is launched. The placeholders use percent markers and

are case-insensitive:

• %computer_name% - the selected computer name.

• %computer_ip% - the resolved IP address of the computer.

• %user_name% - the user account stored on the computer entry (or the selected user session, when

launched from the User sessions tab).

• %user_password% - the password stored with that account, when one is set.

• %path% - the program-name or path field of the tool itself.

• %session_id% - the selected session ID, when launched against a session or a process row.

Unknown placeholders are left in place. Empty values render as an empty string.

Built-in actions

Two entries do not run an external process; they invoke an internal dialog. The editor hides the

program-name and parameters fields for these:

• Send Message - opens the Send message dialog targeted at the current selection.

• Shutdown/Restart - opens the Reboot / shutdown dialog.

In the menu they look identical to any external tool. Internally they use the %shutdown% and

%send_message% markers in the Program name field.

Import, export, reset

The Manage tools dialog's menu has commands to:

• Import tools - read a previously exported file. New entries are added without removing existing ones;

categories that already exist are reused.

• Export tools - write every tool and category to a file. The export dialog offers JSON, XML, and plain text

formats.

• Reset to defaults - delete everything and re-import the shipped defaults.

Default tools that ship

The seed commands.sql defines 12 categories with 127 entries in total. Most are PowerShell one-liners

that target the selected computer through %computer_ip% or %computer_name%. A few launch MMC

snap-ins, mstsc.exe, Windows Explorer, or the Sysinternals utilities. Two are the built-in Shutdown and

Send Message actions described above.

The sections below list every default tool by name with a one-line description. Each entry can be edited or

deleted from Manage tools.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/sending-a-message/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/rebooting-and-shutting-down/
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Network Diagnostics

Tool What it runs

Ping - basic test Test-Connection with 4 echo requests

Ping - continuous
Test-Connection in an infinite loop, one per

second

Traceroute
Test-NetConnection -TraceRoute showing the

hop list

Traceroute - detailed
Test-NetConnection -TraceRoute with the full

object output

Test port - Telnet (23) Test-NetConnection -Port 23

NetBIOS information (Name) nbtstat -a <name>

NetBIOS information (IP) nbtstat -A <ip>

DNS lookup Resolve-DnsName for the selected name

ARP table (remote) Get-NetNeighbor filtered to reachable neighbors

Test-NetConnection - detailed
Test-NetConnection -InformationLevel

Detailed

Test port - RDP (3389) Test-NetConnection -Port 3389

Test port - HTTP (80) Test-NetConnection -Port 80

Test port - HTTPS (443) Test-NetConnection -Port 443

Test port - SMB (445) Test-NetConnection -Port 445

Test port - WinRM (5985) Test-NetConnection -Port 5985

Test-Connection - extended Test-Connection -Count 10 -Delay 1

Routing table Get-NetRoute on the remote session

Port scan (common ports)
Loops Test-NetConnection over 21, 22, 23, 25,

53, 80, 135, 139, 443, 445, 3389, 5985

Administrative Tools

Tool What it runs

Explorer - network shares Windows Explorer on \\<computer_ip>

Remote Desktop (RDP) mstsc /v:<computer_ip>

RDP - fullscreen mode mstsc /v:<computer_ip> /f

Shutdown/Restart Built-in reboot / shutdown dialog

Send Message Built-in send-message dialog

Computer Management compmgmt.msc aimed at the remote computer

Services Management services.msc aimed at the remote computer

Event Viewer eventvwr aimed at the remote computer

Local Users and Groups lusrmgr.msc

Shared Folders fsmgmt.msc

Task Scheduler taskschd.msc

WMI Control wmimgmt.msc

Print Management printmanagement.msc

System Information msinfo32 /computer <name>
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PowerShell Remote

Tool What it runs

Remote PowerShell Session Enter-PSSession against the remote machine

Running Services Get-Service filtered to status Running

Installed Software
Get-ItemProperty on the Uninstall registry keys

(32- and 64-bit)

System Uptime
Win32_OperatingSystem.LastBootUpTime

minus now

Network Adapters
Get-NetAdapter with name, status, MAC, link

speed

IP Configuration Get-NetIPAddress

Disk Space
Win32_LogicalDisk rendered as Size / Free /

Used % per drive

Logged On Users quser /server:<name>

Test WinRM Connection Test-WSMan

Kill Process (interactive)
Prompts for a process name, then Stop-Process

-Force over Invoke-Command

Restart Service (interactive)
Prompts for a service name, then

Restart-Service -Force

System Monitoring

Tool What it runs

CPU Usage (5 samples)
Get-Counter '\Processor(_Total)\%

Processor Time' 5 samples, 2 s apart

CPU - all cores Same counter for every core, 3 samples

Memory Usage
Win32_OperatingSystem rendered as Total / Free

/ Used %

Disk I/O
\PhysicalDisk(_Total)\Disk Reads/sec and

Writes/sec

Network Traffic \Network Interface(*)\Bytes Total/sec

System Errors (last 20)
Get-EventLog -LogName System -EntryType

Error -Newest 20

Application Errors (last 20) Same for the Application log

System Warnings (last 20) Same for System log with EntryType Warning

Services Status Count Get-Service grouped by status

Recent Windows Updates Get-HotFix sorted by install date, top 15

Active TCP Connections Get-NetTCPConnection -State Established

Performance Summary
CPU %, Memory available MB, Disk Time % over 3

samples
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Remote Desktop Services

Tool What it runs

Active RDP Sessions qwinsta /server:<name>

RDP Sessions (detailed)
Win32_LogonSession filtered to LogonType=10

(RDP)

RDP Licenses Status
Win32_TSLicenseKeyPack from

root/cimv2/TerminalServices

RDP Connection History
TerminalServices LocalSessionManager events 21,

24, 25 (last 20)

Security & Audit

Tool What it runs

Local Administrators
Members of the local Administrators group via

Win32_GroupUser

Logon Events (successful) Security log event 4624, last 20

Logon Events (failed) Security log event 4625, last 20

Security Group Changes
Security log events 4728 / 4729 / 4732 / 4733 (group

membership)

Audit Policies
auditpol /get /category:* over

Invoke-Command

Open Ports and Processes
Listening TCP ports cross-referenced with owning

process

Firewall Rules (enabled) Get-NetFirewallRule filtered to Enabled=True

Shared Folders and Permissions Get-SmbShare + Get-SmbShareAccess per share

Scheduled Tasks
Get-ScheduledTask with next-run time, excluding

disabled

Startup Programs (Run keys) HKLM and HKCU Run registry hives

Security Patches Installed
Get-HotFix filtered by Description like

'*Security*'

BitLocker Status Get-BitLockerVolume on each mount point

Windows Defender Status Get-MpComputerStatus

Recent Security Events
Get-EventLog -LogName Security -Newest

30

Remote Desktop Users Members of the local Remote Desktop Users group

Firewall Profile Status
Get-NetFirewallProfile for Domain / Private /

Public
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System Tools

Tool What it runs

Operating System Information
Win32_OperatingSystem (Caption, Version, Build,

OSArchitecture, Install date, Last boot)

BIOS Information Win32_BIOS full object

Processor Information
Win32_Processor with cores, logical processors,

clock speed, load

Motherboard Information Win32_BaseBoard

Physical Memory (modules) Win32_PhysicalMemory per slot

Video Controllers Win32_VideoController

Network Adapters (detailed)
Win32_NetworkAdapterConfiguration for

IP-enabled adapters

Printers Win32_Printer

Environment Variables Get-ChildItem Env: over Invoke-Command

Domain Information
Win32_ComputerSystem (Domain, DomainRole,

Workgroup)

Running Drivers Win32_SystemDriver filtered to State=Running

Network Shares

Tool What it runs

Open C$ (system drive) Explorer on \\<ip>\c$

Open D$ (drive D) Explorer on \\<ip>\d$

Open E$ (drive E) Explorer on \\<ip>\e$

Open ADMIN$ (Windows) Explorer on \\<ip>\admin$

All Shared Folders Get-SmbShare with path, description, state

Share Permissions Get-SmbShareAccess per share

Open Files on Server Get-SmbOpenFile

SMB Sessions
Get-SmbSession with client name, idle / existence

time

Sysinternals Suite

These entries assume the Sysinternals binaries (psexec.exe, psinfo.exe, etc.) are on the program's

PATH. They will not work if Sysinternals is not installed; edit the tool to point at the executable's full path.

Tool What it runs

PSExec - remote CMD psexec \\<name> cmd

PSExec - remote PowerShell psexec \\<name> powershell.exe

PSExec - interactive session psexec \\<name> -i cmd

PsInfo - system information psinfo -h -s -d \\<name>

PsLoggedOn - logged users psloggedon \\<name>

PsList - process list pslist \\<name>

PsService - service management psservice \\<name>

PsFile - open files psfile \\<name>
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Advanced Diagnostics

Tool What it runs

Remote Registry - SOFTWARE
Get-ChildItem HKLM:\SOFTWARE over

Invoke-Command

Remote Registry - SYSTEM Same for HKLM:\SYSTEM

WMI Query - connection test
Fast Win32_OperatingSystem probe; confirms

WMI reachability

CIM Session - test
Opens a CimSession, queries

Win32_ComputerSystem, closes it

Network Routes Get-NetRoute excluding IPv6 link-local

Disk Volumes Win32_Volume filtered to fixed drives

Windows Update Log Get-WinEvent -LogName Setup last 30

TCP/IP Settings Get-NetTCPSetting

Reboot History
System log events 1074, 6005, 6006, 6008 (shutdown

/ startup / unexpected)

Update Management

Tool What it runs

All Installed Updates Get-HotFix sorted by install date

Updates from Last Month Same filtered to the last 30 days

Critical Updates
Get-HotFix filtered by Description like

'*Security*' or '*Critical*'

Windows Update Service Status Get-Service wuauserv

Windows Update Settings
Read of

HKLM:\SOFTWARE\Policies\Microsoft\Windows\WindowsUpdate

Pending Reboot Status
Tests the RebootRequired and RebootPending

registry keys

WSUS Server (if configured) Reads WUServer from the policy registry key

Performance Management

Tool What it runs

Disk Performance
All \PhysicalDisk(*)\* counters, filtered to

averages

Network Performance All \Network Interface(*)\* counters

Memory Statistics All \Memory\* counters

Processes - top by CPU
Win32_PerfFormattedData_PerfProc_Process

sorted by CPU, top 15

Processes - top by RAM Get-Process sorted by working set, top 15

Processes - top by disk I/O \Process(*)\IO Data Bytes/sec sorted, top 10

Processes - top by connections
Get-NetTCPConnection grouped by owning

process, top 15

CPU by Core
\Processor(*)\% Processor Time for every

core, 5 samples

System Bottleneck Analysis
CPU %, Memory Pages/sec, Disk Queue Length,

Network Bytes Total/sec
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Requirements

These defaults assume the target computer is reachable over WMI / WinRM and that the connecting

account has administrator rights on the target. Specifically:

• WMI namespaces root\cimv2, root\cimv2\TerminalServices, and root\StandardCimv2 (for

Get-Net* cmdlets) must be reachable. Open the Windows Management Instrumentation (WMI)

firewall group on the target.

• WinRM must be enabled for the PowerShell Remote category (Enable-PSRemoting -Force).

• The Sysinternals Suite category needs the binaries on the path or full paths supplied in the Program

name field.

• For SMB-based shortcuts (\\<ip>\c$, Get-SmbShare, Get-SmbOpenFile) the File and Printer

Sharing firewall group must be allowed and the account must have administrator rights on the target.

Where a tool fails, the PowerShell window stays open (every default uses -NoExit), so you can read the

error text and adjust permissions or firewall rules.

Entity details

The Details dialog shows every metric the program tracks for one selected server, user session, or process,

plus a chart for the focused metric. Use it when one column on the main grid isn't enough and you want

every number for one entity in one place.
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How to open it

• Double-click a row on any data tab, or

• Right-click a row and choose Details... (the last item on the context menu).

The dialog opens with the entity already loaded.

Layout

The top half is a property tree with five columns:

• Property - the metric name, grouped under category nodes.

• Value - the current value.

• Min / Avg / Max - running statistics for numeric metrics, computed over the graph time range.

Below the tree is a chart label and a chart panel that plots the focused metric over time, much like the graph

panel on the monitoring tabs. Click a property row to switch the chart to that metric (when one is available).

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graphs-overview/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graphs-overview/
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What it shows

The category list depends on the entity type. Each category groups related properties; numeric properties

show Min, Avg, and Max alongside the current value.

Server

• Server - Name, Users, Active users, Idle users, Disconnected users, Sessions, Processes, Uptime.

• Performance - CPU usage, Memory total, Memory usage, Memory usage %, Memory available,

Pagefile usage %.

• Disk - Disk free %, Disk free, Disk busy %, Disk queue length, Disk read speed, Disk write speed.

• Network - RDP received rate, RDP send rate, Network received, Network sent, Avg TCP RTT, Avg

output FPS, Avg input FPS, Avg frame quality.

User session

• Session - User, Domain, Session ID, Session, State, Server, Host, Farm.

• Client - Client name, Client address, Client build, Client display, Client directory, Work directory, Initial

program.

• Timing - Logon time, Connect time, Disconnect time, Last input time, Idle time, Session duration,

Connected time.

• Performance - CPU usage, Memory usage, Memory usage %, Processes, Handles, Threads.

• RDP - RDP received rate, RDP send rate, TCP RTT, TCP bandwidth, Output FPS, Input FPS, Frame

quality, Loss rate, Retransmission rate, FEC rate, Frames skipped (client), Frames skipped (network),

Frames skipped (server), Encoding time.

Process

• Process - Name, PID, Server, Session ID, User, User SID.

• Performance - CPU usage, CPU time, Memory usage, Memory usage %, Peak memory, Pagefile

usage, Peak pagefile, Threads, Handles.

For full descriptions of each metric, see the matching reference: Server metrics reference, User session

metrics reference, Process metrics reference.

Refresh

The dialog updates the visible values on a one-second timer and redraws the chart roughly every 250 ms.

The underlying samples are collected at the same interval as the main grid (see Refreshing server data).

What it doesn't do

The dialog is read-only. To act on the entity (send a message, kill a process, reset a session) use the action

from the row's context menu first.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/server-metrics-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/refreshing-server-data/
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If the entity disappears while the dialog is open (process exits, session ends, server drops), the dialog

detaches: the chart freezes at the last sample and values stop updating. Close the dialog when you're done.
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Graphs and charts

Each of the three data tabs (Servers, User sessions, Processes) has a graph panel below the tree. The

panel plots one metric over time for every checked row in the tree above. Use it to see trends a single

number cannot show: when CPU started climbing, how long a memory leak has been growing, when RDP

latency spiked.

Each data tab keeps its own independent set of charts, with a tab strip of the metrics you have enabled. A

row becomes a series when you tick its checkbox, so you decide exactly which servers, sessions, or

processes are compared side by side. The time axis scrolls left as new samples arrive, and the value axis

scales to the metric (percent, bytes per second, megabytes, or a plain count).

This section explains which metrics each entity type can plot, how to choose which ones appear as tabs,

and how to drive the chart with the context menu - pause, time range, auto-scale, grid, legend, and tooltips.

It finishes with the reference tables for server, user session, and process metrics, and with copying or

exporting a chart as an image.

In this section

• Graphs overview

• Choosing which metrics to graph

• Server metric graphs reference

• User session metric graphs reference

• Process metric graphs reference

• Graph controls

• Copying and exporting graphs

Graphs overview

The graph panel lives below the data tree on every monitoring tab. Each tab has its own independent set of

charts.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graphs-overview/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/choosing-which-metrics-to-graph/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/server-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/user-session-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/process-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graph-controls/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/copying-and-exporting-graphs/


Terminal Services Manager - Terminal Services Manager handbook

What it plots

One series per row in the tree above. A row contributes a series when its checkbox is ticked; clearing the

checkbox removes the series from the chart. The currently selected row is highlighted with a thicker line.

Tabs of metrics

Across the top of the panel is a tab strip with one tab per metric you have enabled (for example, CPU

usage, Memory usage %, Network received); see choosing which metrics to graph to control which ones

appear. Click a tab to switch the chart. The metrics shown match the chosen entity type:

• Servers tab - 26 server-level metrics (see Server metric graphs reference).

• User sessions tab - 21 per-session metrics (see User session metric graphs reference).

• Processes tab - 6 per-process metrics (see Process metric graphs reference).

Time axis

The horizontal axis is time. New samples appear on the right and slide left as time passes. The default time

window is 5 minutes; you can shorten or lengthen it from the graph context menu (see Graph controls).

Value axis

The vertical axis is the value, scaled to the metric: percentages 0-100, bytes per second auto-formatted (B/s,

KB/s, MB/s, GB/s), megabytes for memory, count for things like processes and handles. Auto-scale is off by

default, so the axis keeps a fixed range scaled to the metric; turn it on to let the axis adjust to the data.

Showing or hiding the panel

Drag the splitter between the tree and the panel to resize either side. The split position is remembered

between sessions.

Choosing which metrics to graph

Of the metrics the program can plot, only some show up as tabs on the panel out of the box. You choose

which appear from the metric tab strip below the chart.

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/choosing-which-metrics-to-graph/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/server-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/user-session-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/process-metric-graphs-reference/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graph-controls/
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The metric tab menu

Right-click the metric tab strip (the row of metric names below the chart) on the tab whose metrics you want

to edit (Servers, User sessions, or Processes). The menu lists every metric the program collects for that

entity type, each with a checkbox - tick or untick a metric to show or hide its tab directly.

The list differs by tab - Servers, User sessions, and Processes each expose their own metrics:

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/server-metric-graphs-reference/
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For the same choices in a dialog (with Select all, Clear, and Defaults buttons), choose Graph settings...

from that menu, or Servers / Users / Processes > Graphs > Graph settings... on the main menu while the

matching tab is active.

What the checkbox does

A ticked metric becomes a tab in the panel for that data tab. An unticked metric is hidden; ticking it later

restores the tab. The metrics themselves are always collected; the dialog only controls visibility.

Buttons

• Select all - tick every metric.

• Clear - untick every metric.

• Defaults - reset to the shipped defaults for this entity type.

• OK - save the selection and rebuild the metric strip.

• Cancel - keep the layout that was in place when you opened the dialog.

Defaults that ship

• Servers: CPU usage, Memory usage %, Processes, Users, Active users, RDP received rate, RDP send

rate, Disk free %, Disk read speed, Disk write speed, Network received, Network sent, Connection

quality.

• User sessions: CPU usage, Memory usage, Memory usage %, Processes, RDP received rate, RDP

send rate, TCP RTT, TCP bandwidth, Output FPS, Loss rate, Handles, Threads, Connection quality.
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• Processes: every available metric (CPU usage, Memory usage, Memory usage %, Pagefile usage,

Threads, Handles).

The defaults are tuned for "the numbers most people watch first". Add the niche ones (frames skipped, FEC

rate, encoding time) when you need to dig into RDP quality. To change the defaults that every newly opened

chart starts with, see graph options in Preferences.

Server metric graphs reference

The Servers tab graph panel can plot any of these 26 metrics over time. Each metric is also a column on the

tab; see Server metrics reference for what each one measures. The Default column says whether the metric

appears in the panel out of the box. The matching panels for the other tabs are covered in the user session

metric graphs reference and the process metric graphs reference.

System

Metric Unit Default

CPU usage % shown

Memory usage MB hidden

Memory usage % % shown

Available memory MB hidden

Sessions and users

Metric Unit Default

Processes count shown

Sessions count hidden

Users count shown

Active users count shown

Idle users count hidden

Disconnected users count hidden

RDP traffic

Metric Unit Default

RDP received rate B/s shown

RDP send rate B/s shown

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/graph-options/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/the-servers-tab/
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Disk

Metric Unit Default

Disk free % % shown

Disk free MB hidden

Disk read speed B/s shown

Disk write speed B/s shown

Disk busy % % hidden

Disk queue length count hidden

Network

Metric Unit Default

Network received B/s shown

Network sent B/s shown

Memory

Metric Unit Default

Pagefile usage % % hidden

RDP quality (averaged across sessions)

Metric Unit Default

Avg TCP RTT ms hidden

Avg output FPS fps hidden

Avg input FPS fps hidden

Avg frame quality % hidden

Connection quality % shown

User session metric graphs reference

The User sessions tab graph panel can plot any of these 21 metrics. See User session metrics reference for

what each one measures. The matching panels for the other tabs are covered in the server metric graphs

reference and the process metric graphs reference.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-user-sessions/the-user-sessions-tab/
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Performance

Metric Unit Default

CPU usage % shown

Memory usage MB shown

Memory usage % % shown

Processes count shown

Handles count shown

Threads count shown

RDP traffic

Metric Unit Default

RDP received rate B/s shown

RDP send rate B/s shown

TCP bandwidth B/s shown

RDP quality

Metric Unit Default

TCP RTT ms shown

Output FPS fps shown

Input FPS fps hidden

Frame quality % hidden

Loss rate % shown

Retransmission rate % hidden

FEC rate % hidden

Frames skipped (client) count hidden

Frames skipped (network) count hidden

Frames skipped (server) count hidden

Encoding time ms hidden

Connection quality % shown

Process metric graphs reference

The Processes tab graph panel can plot any of these 6 metrics. See Process metrics reference for what

each one measures. The matching panels for the other tabs are covered in the server metric graphs

reference and the user session metric graphs reference.

https://lizardsystems.com/terminal-services-manager/help/handbook/managing-processes/the-processes-tab/
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Metric Unit Default

CPU usage % shown

Memory usage MB shown

Memory usage % % shown

Pagefile usage MB shown

Threads count shown

Handles count shown

Every available process metric is on by default; the process panel is the most compact of the three.

Graph controls

Right-click the chart for the context menu, or open View > Graph on the main menu bar for the same set of

controls. Most settings are per-tab and are remembered between sessions. To set the values that every

newly opened chart starts with, see graph options in Preferences.

Pause

Pause freezes the chart in place; new samples stop arriving until you turn pause off. The data is still being

collected behind the scenes, so when you resume the chart will jump forward to the current time. Use pause

to study a recent spike without it scrolling out of view.

Time range

Time range opens a submenu of presets: 1, 2, 5 (default), 10, 15, 30, 45, and 60 minutes. The chosen

value is the visible width of the time axis.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/graph-options/
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A longer time range needs more buffered samples and uses more memory; the program keeps history for at

least the maximum selected time range.

Auto-scale

Auto-scale lets the value axis adjust to whatever the data covers, with a margin above the maximum.

Turning auto-scale off freezes the axis at its current min and max so a brief spike does not rescale

everything. Toggle this when you want to compare the size of changes rather than the exact values.

Grid

The Grid submenu toggles the grid lines:

• Vertical lines - vertical grid lines at time-axis ticks.

• Horizontal lines - horizontal grid lines at value-axis ticks.

Defaults: both on.

Axis labels

The Axis labels submenu toggles the axis names:

• X axis - "Time" beneath the time axis.

• Y axis - the unit (for example, "%", "MB", "B/s") next to the value axis.

Defaults: both on.

Series markers and fill

• Markers - draw a small dot at every sample. Helpful when the series has few points or when you want to

read individual values.

• Fill selected - fill the area between the line and the value-axis baseline with a light tint of the series

color. Helpful for showing magnitudes when several series overlap.

Both default to on.

Legend

The Legend submenu controls what the per-series label shows:

• Position - submenu with None, Right (default), Left, Top, Bottom.

• Current - the most recent value.

• Minimum - the minimum over the visible time range.

• Maximum - the maximum.

• Average - the arithmetic mean.
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Tick combinations to taste; turning Minimum, Maximum, and Average all on gives a compact statistical

summary alongside the live value.

Tooltip mode

Tooltip lets you pick what hovering the chart shows:

• None - no tooltip.

• All series - one tooltip line per series, at the time the cursor is over (default).

• Nearest point - just the value of the series the cursor is closest to.

The tooltip is anchored to the mouse position; the time it reports is the time at the cursor.

Copying and exporting graphs

You can grab a snapshot of the current chart as an image, either onto the clipboard for pasting into a

message or as a file for an attachment or report.

Copy to clipboard

Right-click the chart and choose Copy to clipboard. The image of the chart as currently rendered (including

the legend, grid, and axis labels) is placed on the clipboard as a bitmap. Paste with Ctrl+V into anything that

accepts pasted images (a chat client, an email, a document, a screenshot tool).

Save as image

Right-click the chart and choose Save as image.... A save-file dialog opens with a default name based on

the metric.

The dialog writes a single PNG image; that's the only format the exporter supports. The exported image

matches what's on screen: the same metric, the same time range, the same series, the same axis settings.

If you need JPEG or another format, open the PNG in any image editor or use Copy to clipboard and paste

into a tool that lets you save in the format you need.

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graph-controls/
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What is captured

A chart export is a snapshot at the moment you press the action. It is not a live or animated image; it does

not include history beyond the visible time range. For a recurring snapshot (every hour, every day), script the

program with the same export action.

To capture the entire panel (the strip of metric tabs plus the chart), use a screenshot tool; the Save as

image... action only captures the active tab's chart.
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Application log

The Application log is the fourth tab in the right-hand pane. It is the program's own runtime log: every

server query, every action you triggered, every refresh that failed. Use it to investigate why a connection is

not working, to confirm an action was sent, or to attach a recent excerpt to a support ticket.

Unlike the data tabs, the log does not depend on any selection in the computer list. Each row is one event

with a timestamp, a severity level, a category, and a message. The filter strip across the top lets you narrow

the view by level, by category, or by free-text search, so you can isolate the handful of entries that matter

during troubleshooting.

This section describes the layout of the tab, what each of the five severity levels means, how to filter and

search the entries, and how to copy or export them. When you file a support ticket, the recommended path

is to set the view to all levels, reproduce the problem, and export the result as a focused log rather than

narrating the screen.

In this section

• The Application log tab

• Log levels

• Filtering and searching log entries

• Copying and exporting log entries

https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/filtering-and-searching-log-entries/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/the-application-log-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/the-application-log-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/log-levels/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/filtering-and-searching-log-entries/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/copying-and-exporting-log-entries/
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The Application log tab

The Application log tab opens the program's runtime log. Each row is one event: a refresh, an action, a

connection, an exception. The tab is independent of the Servers, Users, and Processes tabs; it does not

depend on any selection in the computer list.

Layout

• Filter strip across the top: text search, five level toggle buttons (Debug, Info, Warning, Error, Fatal), an

All toggle, a category dropdown, and a clear-filter button.

• Log grid below: one row per entry with columns for the timestamp, level icon, category, and message.

• Status label on the right end of the filter strip shows how many rows are visible out of the total kept in

memory.

Columns

• Time - when the event was recorded, local time.

• Level - the severity (Debug / Info / Warning / Error / Fatal), shown with a colored icon for Info and above;

Debug rows are gray with no icon.

• Category - a short string identifying the subsystem that emitted the entry (Server, Action, Update,

Auth, and so on). Useful for filtering.

• Message - the human-readable description, plus any extra parameters formatted into the string.

https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/log-levels/
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How much is kept

The viewer keeps the most recent 10,000 entries in memory by default. Older entries scroll off the top as

new ones arrive. The persistent on-disk log (configured in the Logging preferences) keeps more; the

in-memory view is just what the tab can show quickly.

Sorting

Rows are listed in arrival order, most recent at the bottom. Click the Time column header to flip the order;

click another header to sort by that column.

See also

• Log levels

• Filtering and searching log entries

• Copying and exporting log entries

Log levels

Every entry in the application log has one of five severity levels. The level sets the row's color (and, for Info

and above, a status icon) and how the level buttons on the filter strip affect visibility.

The five levels

• Debug (gray) - diagnostic detail. Per-server timings, intermediate steps, decision points. Useful for

development and for tracing an unexpected failure; otherwise verbose. Debug messages are not

localized; they are always in English.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/logging/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/log-levels/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/filtering-and-searching-log-entries/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/copying-and-exporting-log-entries/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/filtering-and-searching-log-entries/
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• Info (blue) - normal operation. Programmer-initiated actions, successful connections, refresh ticks,

configuration changes. Default minimum level for most users.

• Warning (amber) - something is not right, but the program continued. A retry that succeeded, a

deprecated API path, a stale credential. Worth reading on a quiet day; ignore on a busy one.

• Error (red) - the operation failed. A connection refused, a permission denied, a timeout. The relevant

rows are the first place to look when troubleshooting.

• Fatal (dark red) - an unhandled exception or programming error caught by the runtime. Always a bug;

please report.

Level button row

The filter strip has one button per level plus an All button. Tick the levels you want to see. Untick a level to

hide its rows. All toggles every level on or off.

The chosen levels are remembered between sessions.

Which levels go to disk

The level threshold for the on-disk log file is independent of the level filter on the tab; configure it on the

Logging preferences page. File logging is off by default; when you turn it on, the default minimum level is

Error and above. The tab itself shows everything (any level the in-memory writer was told to keep).

Reporting an issue

If you are filing a support ticket, set the tab to All levels, reproduce the issue, then export the visible rows

(Copying and exporting log entries). The exported file gives the support team the context they need without

screen-by-screen narration.

Filtering and searching log entries

The filter strip above the log grid narrows the visible rows by level, by category, and by free-text search.

Combine the three to find the entries you care about.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/logging/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/logging/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/copying-and-exporting-log-entries/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/log-levels/
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Text search

The text field on the left of the strip is a substring search across the Message column of the log grid. As you

type, rows that do not contain the substring are hidden. Matching is case-insensitive.

Filtering does not run on every keystroke; the program waits a short moment after you stop typing before

applying the filter, so long search strings do not redraw the grid on every character.

The clear button (the small x icon) on the right edge of the field clears the search.

Level buttons

Each of the Debug, Info, Warning, Error, Fatal buttons toggles whether that level appears. All is a shortcut

to turn every level on (or off, if every level is already on).

The current level selection combines with the text search and the category filter using AND: a row must

match every active filter.

Category dropdown

The category dropdown lists every category that has appeared in the log since the program started. Pick a

category to see only its entries; clear the box (or use Clear) to clear the category filter.

The list is auto-populated and refreshes when you open the dropdown, so a category that first appears

mid-session is available without restarting.

https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/the-application-log-tab/
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Clear

The Clear button on the right edge of the strip resets everything: text search empty, all levels ticked,

category cleared. Use it to get back to the full log in one click.

Status indicator

The status label on the right of the strip shows the count: <visible> of <total>. When a filter is active

the visible count drops below the total; clearing the filter brings them back in sync.

Copying and exporting log entries

The log can be copied to the clipboard for pasting into a message, exported as a file for an attachment, or

cleared to start fresh.

Copying to the clipboard

Right-click the log grid for the context menu:

• Copy row - the selected rows, each formatted as [timestamp] [level] [category] message.

• Copy cell - just the focused cell.

• Copy all rows - every visible row, columns separated by commas.

The clipboard format is plain text suitable for pasting into a chat client, a ticket, or a spreadsheet.

Exporting to a file

Pick Export to file... from the context menu. A save dialog opens with the default extension .csv.

Supported formats (chosen by the Save as type dropdown):

• CSV (.csv) - opens in Excel; useful for sorting and pivoting.

• JSON (.json) - one object per entry; useful for piping into a log-analysis tool.

• Text (.txt) - one entry per line, columns separated by whitespace.

The export contains exactly the visible rows in the same order as the screen. Hidden rows (filtered out, or

scrolled out of the in-memory buffer) aren't included.

https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/filtering-and-searching-log-entries/
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Clearing the log

Clear log in the context menu (and as a separate action on the application's main action list) removes every

entry from the in-memory log. The on-disk log file is not touched; clearing the view only resets the tab.

Use Clear when you want a clean baseline before reproducing an issue.

Attaching the log to a support ticket

The recommended workflow:

1. Set the level buttons to All.

2. Click Clear log.

3. Reproduce the issue.

4. Export to JSON or CSV.

5. Attach the file to your ticket.

A focused log starting just before the failure is more useful than a giant log from yesterday.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/logging/
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Preferences

The Preferences dialog gathers every persistent setting that controls how Terminal Services Manager looks

and behaves. Open it once after installation to set the server refresh interval, the appearance, and the

logging level; revisit it when something stops working the way you want.

The dialog is split into pages, each reached from the navigation tree on the left. The pages group related

settings: startup and display behavior, how the computer list is shown, how servers are polled and how their

state is verified, theme and colors, software updates, logging, and graph defaults. A header banner names

the page you are on and gives a one-line summary of what it controls.

Open Preferences from File > Preferences... or with the wrench button on the toolbar. Click OK to save and

apply your changes, or Cancel to discard them. Most settings take effect immediately; a few file-logging

changes wait until the next log file is opened.

In this section

• Opening Preferences - where to find the dialog and how its pages are laid out

• Behavior - startup, exit, and display formats

• Computer list display - how the left-hand computer list is shown

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/refreshing-server-data/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/opening-preferences/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/behavior/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/computer-list-display/
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• Server settings - refresh interval, timeouts, RDP options, and graph data collection

• Server state verification - how the program checks whether a server is reachable

• Appearance - theme and percentage-bar rendering

• Software updates - update mode and check frequency

• Logging - log levels and the on-disk log file

• Graph options - graph defaults used across the program

Opening Preferences

Choose File > Preferences... from the main menu, or click the wrench button on the toolbar.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-settings/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-state-verification/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/appearance/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/software-updates/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/logging/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/graph-options/
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Layout

• Navigation tree on the left, one entry per page.

• Header banner at the top of the content area shows the selected page's title and a one-line description.

• Content area with the page's controls. Three pages have inner tabs: Terminal Services (General /

Graphs), Appearance (Theme / Data display), and Graphs (Chart / Behavior).

• OK and Cancel buttons at the bottom.

Pages

In order:

• General - startup, exit, and display formats. See Behavior.

• Network - how the program checks whether a server is reachable. See Server state verification.

• Computer list - how the left-hand computer list is displayed. See Computer list display.

• Terminal Services - server refresh interval, timeouts, RDP options, graph data collection. See Server

settings.

• Appearance - theme and percentage-bar rendering. See Appearance.

• Software updates - update mode and check frequency. See Software updates.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/behavior/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-state-verification/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/computer-list-display/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-settings/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/server-settings/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/appearance/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/software-updates/
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• Logging - log levels and the on-disk log file. See Logging.

• Graphs - graph defaults across the program. See Graph options.

OK and Cancel

• OK saves every change and closes the dialog.

• Cancel discards every change made in the dialog session.

Validation errors block OK; the page with the bad value stays focused and an error message tells you what's

wrong.

When changes take effect

Most preferences apply immediately when you click OK: a new refresh interval is used on the next scheduler

tick, a new theme repaints the program. A few file-logging changes (path, format) take effect when the next

log file is opened.

Behavior

The General page covers small behavioural choices and the way numeric values are displayed.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/logging/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/graph-options/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/refreshing-server-data/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/refreshing-server-data/
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Startup and exit

• Don't show Add computers from... if the computer list is empty - tick to suppress the wizard that

appears the first time the list is empty. Useful once you have built the computer list and do not want the

wizard to nag.

• Confirm on exit - tick to ask "Are you sure?" when closing the program. Default on.

Display formats

These affect how sizes, speeds, and timestamps are rendered in columns, charts, tooltips, and exports.

• Size format - how byte sizes are displayed. Seven Dynamic presets pick the unit (K / M / G or up to T)

and the number of decimals automatically: Dynamic (x.x K/M/G), Dynamic (x K/M/G), Dynamic (x.xx

K/M/G), Dynamic (x.x K/M/G/T), Dynamic (x K/M/G/T), Dynamic (x.x K/M), and Dynamic (x K/M). Two

fixed presets, Bytes and Kilobytes, always use that one unit. The default is Dynamic (x.x K/M/G) and

works for most users.

• Speed format - the same nine presets as Size format (seven Dynamic plus Bytes and Kilobytes). The

default is Dynamic (x.x K/M/G).

• Speed unit - Bits per second (default) or Bytes per second. Bits per second is the convention in some

networking tools; bytes per second matches Task Manager.

Display-format changes affect formatting only; the underlying numbers do not change, and no recalculation

is needed when you switch.

Computer list display

The Computer list page controls how each entry on the left-hand pane is labeled and how the computer list

is kept current.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/
https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/
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Display

• Show computer caption as - what each entry's label looks like. Four options in this order:

• Computer name (Description) - host name first, description in parentheses. Default.

• Description (Computer name) - description first, host name in parentheses.

• Computer name - just the host name.

Description - just the description text.

Show online computers before offline ones - tick to push reachable entries to the top of each group,

with unreachable ones at the bottom. Otherwise the within-group order follows the manual sort (drag and

drop) you set up in the list.

Auto-update

• Automatically update computer list - tick to have the program re-resolve names and refresh the online

/ offline state on a timer.

• Update interval in seconds - how often the auto-update runs. The default is 60 seconds; the field is

enabled only when auto-update is ticked.

https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/organizing-computers-into-groups/
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The auto-update runs in the background; you can use the list while it runs. A name change in DNS or a host

going offline is picked up at the next tick.

Server settings

The Terminal Services page is split into two tabs. The first controls how often servers are polled and how

the program connects; the second controls how much graph data is kept.

General tab

• Automatically refresh server list every - seconds between scheduler ticks. The minimum is 1 second;

the recommended floor is 3-5 seconds on most environments. Default is 10 seconds. See Refreshing

server data for the full picture.

• Server response timeout - how long the program waits for one server to respond before giving up.

Range 10 to 300 seconds, default 30 seconds. A slow server that exceeds the timeout shows an error in

the status icon and is retried on the next refresh tick.

• Connect with /admin option - when ticked, the Remote Desktop action launches mstsc.exe

/admin, which connects to the console (session 0 admin) instead of creating a new user session. Used

to reach the physical console of a server.

https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/refreshing-server-data/
https://lizardsystems.com/terminal-services-manager/help/handbook/monitoring-servers/refreshing-server-data/
https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/connecting-via-remote-desktop/
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• Connect with /multimon option - when ticked, Remote Desktop launches mstsc.exe /multimon,

which spans the RDP window across every monitor you have. Has no effect with a single-monitor setup.

• Consider user idle after - minutes of no input after which the program marks a session as idle. Range 1

to 1440 minutes, default 5 minutes. Used to color the row, to drive the Idle users count, and as the

threshold for Disconnect idle users and Log off idle users actions.

Graphs tab

• Show all users on graph - when ticked, the User sessions chart plots every session, regardless of the

row checkboxes. Useful for ad-hoc browsing; combine with the row filter for focus.

• Collect graph data for unchecked users - when ticked, the program keeps history for sessions even

when their row is unchecked. Switch them on later and you see their history immediately. When unticked,

history starts the moment a row is ticked, which saves memory on a large list.

• Collect graph data for unchecked processes - same idea for the Processes tab.

• Multi-row tabs - when the metric strip has more tabs than fit in one row, tick to wrap them over multiple

rows; untick to scroll them with arrow buttons.

Server state verification

The Network page picks the method the program uses to decide whether a server is reachable. The choice

affects the online / offline icon next to each entry in the computer list and the auto-update logic.

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/
https://lizardsystems.com/terminal-services-manager/help/handbook/building-your-computer-list/
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Method

Three radio options:

• Don't check server state - the program never probes; every entry is treated as reachable until an actual

query fails. Use this when you do not want the icons to flap and you trust the network.

• ICMP ping - the program sends ICMP echo requests to the server. The same protocol ping.exe uses.

Fast and lightweight, but blocked by some firewalls.

• TCP connect to port - the program opens a TCP connection to the chosen port. If the connect succeeds

the server is considered reachable; if not, it is offline.

Port (TCP method only)

• Port - the TCP port to connect to. Range 1 to 65535, default 139 (NetBIOS Session Service). Common

alternatives: 445 (SMB), 3389 (RDP), 80 (HTTP), 443 (HTTPS).
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Timeout

• Default timeout in ms - how long the program waits for the ICMP echo reply or the TCP connect to

succeed before declaring the server offline. Enabled only for ICMP ping and TCP connect. Defaults to

300 ms. Increase it on slower or higher-latency networks; decrease it for a snappier offline / online flip.

Validation

The dialog refuses to save with a port outside 1-65535 or a non-positive timeout. The offending field is

reported in an error message.

Which to pick

• ICMP if the firewall lets it through and you want speed; most local networks allow ICMP from

management hosts.

• TCP on a port the server already exposes (139 / 445 for RDS hosts, 3389 if RDP is allowed) when ICMP

is blocked.

• Off when the icons are noisier than they are useful, or when probing causes alerts in your security

monitoring.

Appearance

The Appearance page has two tabs: Theme picks the dark / light mode and the specific theme used; Data

display controls how the small bars in percentage cells are rendered.
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Theme tab

Appearance mode

• Automatic (follow system settings) - the program matches the Windows mode. When Windows is in

dark mode the program uses the dark theme; in light mode the light theme. Default.

• Always dark - always use the dark theme, regardless of Windows.

• Always light - always use the light theme, regardless of Windows.

Theme selection

• Light theme - the theme used when the resolved mode is light.

• Dark theme - the theme used when the resolved mode is dark.

The dropdowns are populated from the theme registry built into the program. A change applies immediately;

the program repaints without a restart.
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Data display tab

Controls the small horizontal bars that appear in percentage cells (CPU usage, memory percent, disk free

percent, and so on).

Style

• Style - the rendering style for the bar. Seven options:

• None - hide the bar; show only the numeric value.

• Flat - thin solid bar at the bottom of the cell.

• Modern - narrow centered bar with the theme accent color.

• Classic - centered rounded bar, color-coded by value.

• Segmented - discrete blocks with gaps.

• Gradient - smooth green-to-red gradient bar.

• Heat map - semi-transparent fill across the whole cell.

The dropdown shows a live preview of each style on a sample 65% value.

Modifiers

• Color-coded by value - tick to shade the bar by the value (green at low, amber at medium, red at high).

Affects the styles that respond to color shading.

• Rounded corners - tick to round the bar's ends.

• Opacity - track bar that controls how solid the bar is. At 100% the bar is fully opaque; lower values let

the cell background show through.

The settings apply to every cell that uses a percentage progress bar across the program (Servers, User

sessions, Processes tabs, the User profiles dialog).

Software updates

The Software updates page controls how the program checks for new versions and what it does when one

is found.

https://lizardsystems.com/terminal-services-manager/help/handbook/server-administration-tools/user-profiles/
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Update mode

Four radio options:

• Automatic - download and install updates automatically - the program downloads the new version in

the background and installs it on next launch with no prompt.

• Download - download automatically, ask before installing - the new version is downloaded; the

program prompts before applying.

• Notify - only show notification when update available - the program tells you a new version is

available but doesn't download anything; you decide when to act.

• Manual - never check automatically - no automatic check. You can still check manually from Help >

Check for updates....

Check frequency

How often the background check runs. Disabled when Manual is selected.

• On startup - once every time the program launches.

• Daily

• Weekly (default)

https://lizardsystems.com/terminal-services-manager/help/handbook/updates-and-licensing/checking-for-updates/
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• Monthly

Read-only info

The page shows the current state of the updater:

• Current version - the version that is running.

• Last check - the date and time of the last successful check.

• Next check - when the next automatic check is due.

A Check now button forces an immediate check, regardless of the schedule.

Notes

• The check downloads only a small version manifest; it does not transfer the installer until you authorize it.

• If you install Terminal Services Manager through winget, both winget and the built-in updater can keep it

current. See Installing with winget for the full picture; the two do not conflict.

Logging

The Logging page controls how much detail the program writes to its in-memory log (the Application log

tab) and to the on-disk log file.

https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/installing-with-winget/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/the-application-log-tab/
https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/the-application-log-tab/
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Minimum level (in memory)

• Minimum level - the lowest level kept in the in-memory log. Options: Debug, Info (default), Warning,

Error, Fatal. Entries below the threshold are dropped before the in-memory writer ever sees them.

Set this to Debug when you need verbose tracing for support; revert to Info for normal use.

File logging

• Enable file logging - tick to write the log to disk as well as to the in-memory viewer.

• Minimum level - the lowest level written to the file. Can't be lower than the in-memory minimum level;

entries already dropped from memory never reach the file. Defaults to Error.

• Log path - the directory the log files are written into. A browse button marked ... opens a folder picker.

• File prefix - the file-name prefix used for each log file. Files are named

<prefix>_<timestamp>.<ext>.

• File format - CSV (default, comma-separated), Text (one entry per line), or JSON (one object per line,

easy for log-analysis tools).

• Max file size - rotates to a new file when the current one reaches this size. Range 1 to 1000 MB; default

10 MB.

https://lizardsystems.com/terminal-services-manager/help/handbook/application-log/log-levels/
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• Max files count - how many rotated files to keep. Older files are deleted to stay under the count. Range

1 to 100; default 10.

Validation

Saving fails if the log path or prefix is empty or the size / count fields are out of range. An error message

names the offending field.

What happens when you change a setting

In-memory level changes apply immediately; the next entry uses the new threshold.

File-logging changes (enable / disable, level, format, path) apply on save: the current log file is closed, and a

new one with the new settings is opened. The on-disk content from before the change is left intact.

Graph options

The Graphs page sets the defaults that every newly opened graph uses. Changes here do not affect open

charts; each chart has its own toggles in its context menu (see Graph controls).

https://lizardsystems.com/terminal-services-manager/help/handbook/graphs-and-charts/graphs-overview/
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Chart tab

Grid & axis

• Show X axis grid - vertical grid lines at time-axis ticks.

• Show Y axis grid - horizontal grid lines at value-axis ticks.

• Show X axis label - print "Time" beneath the time axis.

• Show Y axis label - print the unit next to the value axis.

Series

• Show series markers - draw a small dot at every sample.

• Show series fill - shade the area between the line and the baseline.

• Autoscale - let the value axis adjust to the data.

• Show all labels - print the value at each visible sample on top of the chart. Useful for short,

sparsely-sampled series; visually noisy for dense ones.

Legend

• Position - where the legend appears: None, Right (default), Left, Top, Bottom.

• Current value - the most recent value in the legend.

• Min - the minimum over the visible range.

• Max - the maximum.

• Average - the arithmetic mean.

Behavior tab

• Time window - the visible time range a new chart opens with. Options: 1, 2, 5 (default), 10, 15, 30, 45,

and 60 minutes.

• Refresh speed - how often the chart redraws. A multiplier on an adaptive base interval:

• Fast - smoothest scrolling, highest CPU usage.

• Normal (default) - balanced.

• Slow - reduced CPU.

• Very slow - minimal CPU, chart scrolls in larger steps.

• Data update only - no continuous redraw; the chart updates only when new samples arrive. The lowest

CPU and battery usage.

• Tooltip mode - what hovering shows: None, All series (default), or Nearest point (only the series the

cursor is closest to).

Apply scope

These are defaults for new graphs. To change an existing chart, use its context menu; the per-chart settings

override the defaults.
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Updates and licensing

This chapter covers two things you need to do once after installation and then occasionally: keep the

program up to date, and register your license. Both run from the Help menu and from a handful of dialogs

the program opens automatically at the appropriate time.

Terminal Services Manager can check for new versions on its own or on demand. When an update is

available, it tells you what changed and offers to download and install it. You decide how often it checks and

whether it does so automatically on the Software updates page of Preferences.

Registering your license removes any usage limits and confirms your purchase. Enter the key you received

once, and the program stores it for good. The pages below walk through both tasks step by step.

In this section

• Checking for updates - check for new versions and install them

• Registering your license - enter your license key to activate the program

Checking for updates

The Software Update dialog tells you whether a newer version of Terminal Services Manager is available,

lets you read the release notes, downloads the installer, and runs it.

https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/installing-terminal-services-manager/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/software-updates/
https://lizardsystems.com/terminal-services-manager/help/handbook/updates-and-licensing/checking-for-updates/
https://lizardsystems.com/terminal-services-manager/help/handbook/updates-and-licensing/registering-your-license/
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How to open it

Choose Help > Check for updates.... The dialog opens and immediately starts a check; you do not need to

click anything to begin.

If the built-in update checker is enabled (see Software updates), the dialog also opens on schedule when a

new version is detected; you do not have to go to Help every time.

Header

The header has a title (always Software Update) and a subtitle that reflects the current state:

• Checking for available updates - the version check is in progress.

• A new version is available - the server returned a newer version.

• Your software is up to date - the installed version matches or exceeds the latest published.

• Downloading update - the installer is being downloaded.

• Ready to install - the installer is downloaded and waiting for permission to run.

• Update check failed - the request did not complete; an error message appears below.

What you see when an update is available

When the server returns a newer version, the dialog shows:

• Current version with an arrow and the Available version next to it, plus the release date.

• A What's new panel with scrollable release notes for the new version.

https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/software-updates/
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Buttons

The button row changes depending on the state:

• Checking state: Cancel.

• Update available state: Download & Install (default), Skip version (skip this specific release; the

dialog only resurfaces when an even newer version appears), Remind later (close the dialog; revisit on

the next scheduled check), Close.

• Up to date state: Close.

• Downloading state: a progress bar with bytes-transferred and current download speed, plus a Cancel

button.

• Ready to install state: Install now (default; closes the program and runs the installer), Later (close the

dialog and leave the downloaded installer in place).

• Error state: Try again, Close.

What happens during install

When you click Install now, the program closes itself and launches the downloaded installer. The new

version starts after the installer finishes; existing settings, the computer list, presets, and credentials are

preserved by the upgrade.

See also

• Software updates - the auto-update settings (channel, frequency).

• Installing with winget - when you would rather let winget manage updates.

Registering your license

The Register Terminal Services Manager dialog accepts a license key and the name the license is issued

to. Once entered correctly, the dialog closes and the program runs as registered from that point on.

https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/installing-terminal-services-manager/
https://lizardsystems.com/terminal-services-manager/help/handbook/preferences/software-updates/
https://lizardsystems.com/terminal-services-manager/help/handbook/getting-started/installing-with-winget/
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How to open it

Choose Help > Enter registration code.... The dialog also opens when you click Enter license key in the

unregistered-version reminder or the support-renewal prompt.

Fields

• Licensed to - the name the license is issued to. Use exactly what was on the license email; spelling and

punctuation matter.

• License key - the license key itself. Keys for Terminal Services Manager begin with LK1-TSM- and are

followed by a long string of characters.

Both fields have a small icon on the left (user / key) and accept paste. Right-click for the standard text menu.

Buttons

• OK - validate the entered name and key, persist them if valid, and close the dialog. Enabled only when

both fields contain text.

• Cancel - close without saving.

What happens on success

After a successful registration the Help > About... dialog shows the licensee name and the license type; the

evaluation and support-renewal reminders stop appearing.

What happens on failure

If the key is malformed, expired, or does not match the name, the dialog stays open and the next attempt is

rejected. Common reasons:

• A typo in either field. Copy and paste the values directly from the license email rather than retyping.

• The key was issued for a different product. Keys for other LizardSystems products carry a different

product tag in the key body and are rejected here. Pick the key tagged for Terminal Services Manager

(the TSM segment).

• The key is older than the installed version's support window.

Storage

By default the license is stored under the Windows user who entered it; other users on the same machine do

not see it. If the program was installed in system-wide mode (run with the /systemwideconfig switch),

the license is shared across all users on the machine. Reinstalling or upgrading Terminal Services Manager

preserves the stored license; uninstalling without removing application data also preserves it.

https://lizardsystems.com/terminal-services-manager/help/handbook/updates-and-licensing/checking-for-updates/
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